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Safety Information  
Observe the following precautions to avoid fire or injury and prevent damage to this product or any 

products connected to it.  

Use this product only for its intended purpose as specified. 

Use only the power adaptor specified for this product and certified for the country of use. 

Ensure that the power source provides the power level supported by the power adaptor. 

To avoid fire or shock hazard, observe all ratings and markings on the product and power supply and 

ensure the product is properly grounded.  

Do not connect or disconnect probes or test leads while they are connected to a voltage source. Connect 

the probe reference lead to earth ground only.   

Do not block the power cord, it should always be accessible to the user.   

Do not operate this product with covers or panels removed. 

If you suspect that there is damage to this product, have it inspected by qualified service personnel.  Do 

not operate with suspected failures.  

Do not operate in wet/damp conditions. Do not operate in an explosive atmosphere. Keep product 

surfaces clean and dry. Provide proper ventilation for operation of product.  

Only qualified Protocol Insight personnel or representatives should perform service procedures. 

Calibration Requirements 
Protocol Insight declares calibration is not required to maintain the accuracy or normal operating 

parameters for the Falcon series UFS/UniPro Exerciser/Analyzers. Ensure the device is used in 

accordance with the OPERATING CONDITIONS for the instrument.  
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Product Overview  
The Falcon series instruments are the established industry standard with powerful protocol analyzer 

and exerciser capabilities and unprecedented flexibility. 

• The Falcon G500C is an analyzer that can capture x2 bi-directional links as a “sniffer”. It supports UFS 

4.0, UniPro 2.0 and M-PHY 5.0 HS-G5.  

• The Falcon G550C is an exerciser/analyzer; it is identical to the G500C analyzer but is also a protocol 

exerciser that can generate link traffic on a x2 bi-directional link while simultaneously capturing the 

response traffic from the DUT. The Falcon G550C exerciser can perform host emulation and execute 

the UniPro and JEDEC Compliance/Conformance Test Suites (CTS). 

• The Falcon G500C / G550C can be purchased with a configurable amount of trace capture depth for 

the analyzer, supporting: 8GB (default), 15GB, 23GB and 30GB of trace capture depth, more details in 

INSTRUMENT. 

Key Features  

Smart Tune™ equalization 
Capturing the signal from the DUT can be problematic when trace routing or the cabling to the test fixture 

causes poor signal integrity or probing issues. Smart Tune™ equalization optimizes signal acquisition at 

the analyzer to ensure error-free MPHY symbol capture.   

Eye Monitor 
Eye Monitor constructs an eye diagram of the link to determine link quality. Qualitative measurements 

can be done on the eye diagram for jitter, noise, and eye opening. This will be enabled in a future release 

of the software.  

Streaming capture 
Streaming capture uses the full 40Gbs bandwidth of Thunderbolt3 to store link traffic directly to disk in 

real time. 

Trace Validation™ (TV) analysis 
Trace Validation uses state machine logic to analyze captured traces algorithmically without user 

intervention. It analyzes bi-directional UniPro and UFS traffic, performing protocol sequence and timing 

analysis and packet header and payload inspection. 

Events view 
Displays events on the bus in a unique time-aligned display, and includes fillers, Prepare, SYNC, Hibern8, 

sleep, stall and other M-PHY level packets. Events view presents a complete picture of all events and 

allows drill-down to the lowest level bytes. 
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Compliance (CTS) Testing (Falcon G550C only) 
Test executive performs compliance verification of UFS 4.0 and conformance verification of UniPro 2.0 

with Compliance/Conformance Test Suites (CTS). It executes a range of CTS test cases, analyzing results 

using the Trace Validation engine and generating pass/fail and summary reports. 

Stimulus for corner case and margin testing (Falcon G550C only) 
Stimulus with full UniPro stack in HW allows creation of specific traffic on the link, offers extensive error 

injection and is capable of full protocol emulation. 

Test executive stress testing (Falcon G550C only) 
Test executive stress testing executes hundreds of thousands of tests automatically. Stop after any 

number of loops or No Result Test Cases. 

Custom test case creation 
Design custom tests to test corner cases or introduce errors for margin, stress, or error recovery testing.  

Editors allow complex test creation, error injection, device control, and protocol sequence and packet 

state machine construction for stimulus and Trace Validation. 

Instrument Description  
The Falcon G500 series consists of an instrument and a power brick. A controller PC with Thunderbolt 3 

connectivity is required and is not included. Other components required for instrument operation that 

are not supplied include 50 ohm matched-length cables and power splitters, or a solder-down probe. See 

ACCESSORIES for more information. 

The Falcon G500 front panel connectors are used to probe links at the Tx, Rx, or the midpoint. The “Sublink 

0 Analyzer” connectors are used to capture and analyze one direction of link traffic while the “Sublink 1 

Analyzer” connectors capture the other direction of link traffic. 

The Falcon G550 “Sublink 1 Tx Exerciser” front panel connectors generate traffic on the link and the 

“Sublink 0 Exerciser/Analyzer” connectors are used to capture and analyze the response traffic. When 

using the instrument as an exerciser the “Sublink 1 Analyzer” connectors are not used. 

The connectors on the front panel are labeled from the instrument perspective, not the DUT perspective. 

So, the connectors labeled Rx are for capturing signals from the bus and connectors labeled Tx are for 

generating traffic on the bus. 
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Exerciser/Analyzer Front Panel - Falcon G500C/G550C 

 

Front panel connectors: 

A. Connect the TxDN and TxDP from device M-Tx lane 1 here. 

B. Connect the TxDN and TxDP from device M-Tx lane 0 here. 

C. Connect the RxDN and RxDP from device M-Rx lane 1 here. This is used for the analyzer only, 

for the exerciser these connectors are not used.  

D. Connect the RxDN and RxDP from device M-Rx lane 0 here. This is used for the analyzer only, 

for the exerciser these connectors are not used. 

E. Connect to the RxDN and RxDP from device M-Rx lane 1 here. This is used for the exerciser 

only, for the analyzer these connectors are not used.  

F. Connect to the RxDN and RxDP from device M-Rx lane 0 here.  This is used for the exerciser 

only, for the analyzer these connectors are not used.  

G. Generates a UFS reference clock on 19.2, 26, 38.4 and 52 MHz at 1.2V. 

H. Generates a 1.2V reset signal. 

I. Trigger in (TRIG IN) to the analyzer, refer to FALCON 500C / 550C - I/O SIGNALS AND VOLTAGE 

OUTPUTS. 

J. Trigger out (TRIG OUT) from the analyzer, refer to FALCON 500C / 550C - I/O SIGNALS AND 

VOLTAGE OUTPUTS. 

K. Ground 

L. Probe power  

Connectors are SMP male, limited detent, 7.0 lb mate force, 5.0 lb demate force.  
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Side Panels 

Right 

 

The Thunderbolt 3 connectors, which are USB Type-C connectors, do not support USB3.0.  

 

Rear 

 

The power connector type is IEC, center pin is +12V. Refer to POWER REQUIREMENTS – EXTERNAL POWER 

SUPPLY for more detail.  
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Licenses Available 

Full  
Falcon Instruments utilize an embedded HW key and no SW license is required. This key is configured 

at the factory, floats with the instrument and works with any PC. 

Offline 
If the application software is launched with no SW or HW key present, the application will enable 

Offline-only capabilities. When Offline the user can open previously saved trace files to analyze the 

trace. The analysis windows available in Offline include the list, protocol decode and events windows. 

Offline-only does not enable the Trace Validation Results window or Trace Validation Editor. 

Offline Viewer with Trace Validation and TV Editor 
This license is a SW license available from support@protocolinsight.com. SW license keys are node-

locked to a PC and are not transferable. Offline with TV and TV Editor operates like the standard Offline 

but enables the Trace Validation Results window and TV Editor to create custom TV tests. 

Offline Viewer with Trace Validation and all Editors 
This license is a SW license available from support@protocolinsight.com. SW license keys are node-

locked to a PC and are not transferable. Offline with TV and all Editors operates like the standard 

Offline but enables the Trace Validation Results window plus all Editors, including the TV, advanced 

trigger, and stimulus Editor. 

 

 

Options and Upgrades 
 

      The Falcon G500C / G550C has a configurable trace capture depth. 
 

Configuration Order Code Trace Capture Depth 

Base Configuration 8GB 

FG5XXC8GB 15 GB1  

FG5XXC16GB 23 GB1 

FG5XXC24GB 30 GB2 

 

      Contact your local representative for a list of available instrument SW/FW upgrades. 

 

  

 
1 Memory buffer is 16 or 24 GB; 1 GB is used for system functions and unavailable for capture 
2 Memory buffer is 32 GB; 2 GB is used for system functions and unavailable for capture 

mailto:support@protocolinsight.com
mailto:support@protocolinsight.com
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Accessories 
FG5AMPSP HS-G5 Amp Splitter, x1 link pre-amplifier for Falcon G500C/G550C (two are 

required to use both sublinks). Includes two pairs of phase matched cables. Use 
this solution to implement a splitter arrangement between the Host and the DUT.  

FG5AMPGR  HS-G5 Grypper Amp Interposer, x2 link pre-amplifier for Falcon G500C/G550C 
Includes four pairs of phase matched cables. The interposer board allows you to 
debug directly in your environment, but either soldering or using a grypper socket 
to attach to the device 153b ball grid array.  

FG5AMPCB HS-G5 Carrier Board for the Falcon G500C/G550C. Includes four pairs of phase 
matched cables. Use this solution to perform CTS testing on UFS devices with the 
Falcon G550C exerciser.   

FG5AMPSP-C12 One pair 1 of phase matched 12" SMP-mini to SMP cables 
 

FG5PSD2  HS-G5 x2 solder probe – 4 signal cables, 2 amplifiers/power cables, 4 probe tips 
FG5PSD01  HS-G5 Probe Amplifier 
FG5PSD05  HS-G5 Probe Tip 
FG5PSD07  HS-G5 Power Cable 
FG5PSD08  HS-G5 Signal Cable 
 
FG4PSD2B  HS-G4B x2 Bundle – 2 pigtail cables with power connectors and probe tips 
FG4PSD05   HS-G4B Coax Multi-lead Probe Tip (6 inch)  
FG4PSD07   Pigtail cable with power connector  
 
FSWOVTVE  Offline Viewer with Trace Validation and TV Editor 
FSWOVTVEDITORS Offline Viewer with Trace Validation and all Editors 
EnhanceConn Enhanced connectivity kit – Thunderbolt 3 6ft/2m 40Gbps active cable and 

retention device 
FAECase  Field carry bag 

 

 

  

https://www.protocolinsight.com/wp-content/uploads/docs/HS-G5%20FG5AMPSP%20Amp%20Splitter%20User%20Guide.pdf
https://www.protocolinsight.com/wp-content/uploads/docs/HS-G5%20FG5AMPGR%20Interposer%20User%20Guide%20RevB.pdf
https://www.protocolinsight.com/wp-content/uploads/docs/HS-G5%20FG5AMPCB%20Carrier%20Board%20User%20Guide.pdf
https://www.protocolinsight.com/wp-content/uploads/docs/HS-G5%20Solder%20Down%20Probe%20User%20Guide.pdf
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Probing Configuration Options  
Depending on the application, analyzer or exerciser/analyzer, there are several different recommended 

probing options for connecting to the DUT provided below. 

Analyzer 

Solder-down 
The probe tips should be soldered to the board, using the tip resistors. The best place to solder the tips is 

as close to the TX pins as possible. The second best location is as close the RX pins as possible. Never 

solder the tips in the middle of the link and this will create reflections and may render the system 

inoperable. The diagram below shows a x1 link and the connections are shown for clarity. A x2 link will 

have four (4) probe tips and two (2) amplifiers.  

 

  



 

Product specifications and descriptions in this document are subject to change without notice. 

© Protocol Insight, LLC 2014 – 2024, Revision 3.3.9, Oct 2024 

9 

Splitters 
For all speeds, including HS-G5, we recommend the AMP splitter, FG5AMPSP. Cables are required for 

the SoC and Host connection to the amp splitter. The cables should be phase-matched, support 

frequencies ≥24GHz, have < 1 dB per ft of insertion loss and be no longer than twelve (12) inches in 

length. We recommend right-angle SMP-mini (SMPm) connectors for the amp splitter side of the cable. 

A removal tool should be used for the SMP or SMPm connectors.  
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Breakout DUT 
For speeds up to HS-G4B, 50% split = 16.7Ω ± 1Ω resistor 

Interposer 

For speeds up to HS-G4B, 50% split = 16.7Ω ± 1Ω resistor 
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Exerciser 
Direct connection between the protocol analyzer and device under test (DUT). 
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Setup and Operation  

General Instrument Configuration 
All general instrument, device and user preference settings can be accessed from either the Settings menu 

or by clicking  from the toolbar. See SETTINGS WINDOW for information on how to change general 

settings. 

Analyzer Configuration 
To configure for general debug analysis or for Trace Validation follow these steps: 

Step 1: Connect the probes 
Note: the labels on the analyzer front panel are from the instrument perspective, refer to TABLE 1. 

1. Connect the Sublink 0 Rx_1N to TxDN from the device M-Tx lane 1.  

2. Connect the Sublink 0 Rx_1P to TxDP from the device M-Tx lane 1. 

3. Connect the Sublink 0 Rx_0N to TxDN from the device M-Tx lane 0.  

4. Connect the Sublink 0 Rx_0P to TxDP from the device M-Tx lane 0. 

5. Connect the Sublink 1 Rx_1N to RxDN from the device M-Rx lane 1.  

6. Connect the Sublink 1 Rx_1P to RxDP from the device M-Rx lane 1. 

7. Connect the Sublink 1 Rx_0N to RxDN from the device M-Rx lane 0.  

8. Connect the Sublink 1 Rx_0P to RxDP from the device M-Rx lane 0. 

See PROBING CONFIGURATION OPTIONS for more information on how to connect to the DUT. Refer to 

DEBUGGING INSTRUMENT CONNECTIVITY for more information on how to validate instrument connectivity.  

When connecting the instrument to the device under test (DUT), care must be taken to ensure the lanes 

are connected to the respective Sublinks and the “P” and “N” connections are preserved. Shown below in 

FIGURE 1, is a picture of the instrument front panel. The host and device must each be connected to a 

single Rx sublink.  

Do not mix Host and Device Lanes between Sublinks. For example, if Host Lane-0 is on Sublink0 Rx0, 

Host Lane-1 must be connected to Sublink0 Rx1. Lane-0 must always be connected to Rx0.   

Connection Width Allowable Sublink Connection 

Host (device M-Rx lane 0) x1 Sublink 0 Rx0 (Lane-0) 
Sublink 1 Rx0 (Lane-0) 

Host (device M-Rx lane 0 and lane 1) x2 Sublink 0 Rx0 (Lane-0) and Rx1 (Lane-1) 
Sublink 1 Rx0 (Lane-0) and Rx1 (Lane-1) 

Device (device M-Tx lane 0) x1 Sublink 0 Rx0 (Lane-0) 
Sublink 1 Rx0 (Lane-0) 

Device (device M-Tx lane 0 and lane 1) x2 Sublink 0 Rx0 (Lane-0) and Rx1 (Lane-1) 
Sublink 1 Rx0 (Lane-0) and Rx1 (Lane-1) 

Table 1 - Allowable Analyzer Connections 
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Figure 1 - Falcon G5xxC Front Panel 

Step 2: Configure the analyzer 
1. Select Analyzer mode on the toolbar (G550C only) 

2. Under Instrument Configuration select the desired memory Capture Options. 

3. Under Instrument Configuration set the Connected Link Width for each direction to x1 or x2. 

4. Under User Preferences determine if UFS packets are decoded when the trace capture is 

complete. 

Step 3: Capture the trace 
1. Configure the trigger from the Tools menu if desired. 

2. Press Analyzer Connect, then Start, and capture the trace. 

Step 4: Configure and run Trace Validation tests 
1. Go to the TV Configuration window. 

2. Select which Trace Validation Tests to run. 

3. Press the Start button and watch the TV Results windows fill with Pass, Fail, Warning, or Info 

results. 
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Debugging Instrument Connectivity 
If the instrument is not connected to the host and DUT properly, you will have difficulty capturing traces.  

Prior to capturing traces, we recommend you set the instrument capture memory to 128 or 256MB of 

depth and trigger on “PACP_CAP_ind” from the host or device and run at lower speed gears, such as HS-

G1. This will allow you to confirm if the lanes are connected correctly, sync lengths requested for the host 

and device appropriate (0x48 or greater) and you can reliably capture at these speeds.  

Once you have validated connectivity, run in higher speed gears and make any needed adjustments to 

SmartTune Equalization settings. The Instrument Status counter can be used to provide a rough metric on 

how the instrument is performing. You should target zero or almost zero Symbol Errors at HS-G5. 

 

Figure 2: Normal Trace PACP_CAP_ext2 

Shown in FIGURE 2 is trace showing the PACP_CAP_EXT2_ind for the Device. The Packet Decode pane on 

the right which decodes the fields within the packet, RxHSG4SyncLength is reported to be 0x4D, which is 

compliant with our minimum values (0x48).  

Shown in FIGURE 3 is the same trace showing the PACP_CAP_EXT1_ind for the Device. The Packet Decode 

pane shows RxHSG1SyncLength, RxHSG2SyncLength and RxHSG3SyncLength are also compliant. 
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Figure 3: Normal Trace PACP_CAP_ext1 

From the UniPro Specification, Section 5.7.6 Trigger Mapping, we can use the TRG_UPR0 physical lane, 

two bit parameter, to confirm the physical lanes are connected properly to the instrument. The UniPro 

specification states the physical Lanes 0 and Lane 1 must send the following EscParam and M-PHY symbol 

pairs:  

- Physical Lane 0 : EscParam 0x40 and M-PHY symbol pair <MK1,0x40>  

- Physical Lane 1:  EscParam 0x41 and M-PHY symbol pair <MK1,0x41>  

Refer to FIGURE 4, there we will use the Traffic Overview Pane to select the last TRG_UPR0 event by 

selecting it and double-clicking it (the arrows  can be used to select other instances). 

Next, we move down the UniPro Packet List, right-click on the TRG_UPR0 event (index 482) and Place 

Bookmark B1. Finally, we click on the UniPro Events pane, scroll down to the bottom, right click in the 

middle of the pane and select Go To, B1. You can see Device Lane 0 and Lane 1 both have the correct 

EscParam and symbol pairs. You can perform the same check on the Host.  

From the same UniPro Specification Section you can also determine how many lanes the host and device 

support. Refer to Table 17, TRG_UPR1 Mapping Examples in Section 5.7.6. Refer to FIGURE 4, there you 

will see the TRG_UPR1 event (outlined in yellow) and the responses from each lane, indicating two lanes 

are supported, 0x83. The host or device will send an EscParam of 0x81, if it determines only a single lane 

is connected. 

- Physical Lane 0 (only) : EscParam 0x81 and M-PHY symbol pair <MK1,0x81>  

- Physical Lane 0 and 1 : EscParam 0x83 and M-PHY symbol pair <MK1,0x83>  
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Figure 4 : Normal Trace TRG_UPR0 and TRG_UPR1 
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FIGURE 5 illustrates an example how a TRG_UPR0 will appear when the physical lanes are swapped on the 

instrument. In this case is connected to the instrument on Sublink0 Rx1 and physical lane 1 is connected 

to the instrument on Sublink0 Rx0. When you look at the EscParam and Symbol Pairs in the trace you will 

see 0x40 appears on Sublink0 Rx1 and 0x41 appears on Sublink0 Rx0. This connection must be corrected, 

or it will not be possible to obtain accurate traces. From Section 5.7.6 of the UniPro Specification, this is 

incorrect and indicates Lane 0 should be connected to Sublink0 Rx0 and Lane 1 should be connected to 

Sublink0 Rx1.  

 

Figure 5: Lane Swap Trace Example 
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Exerciser Configuration (G550C only) 
To configure for compliance/conformance (CTS) testing, corner case, margin or automated stress testing 

follow these steps: 

Step 1: Connect cables 
Note: the labels on the analyzer front panel are from the instrument perspective. The Exerciser TX 

connections must be cabled, refer to EXERCISER.  

1. Connect the Sublink 0 Rx_1N to TxDN from the device M-Tx lane 1.  

2. Connect the Sublink 0 Rx_1P to TxDP from the device M-Tx lane 1. 

3. Connect the Sublink 0 Rx_0N to TxDN from the device M-Tx lane 0.  

4. Connect the Sublink 0 Rx_0P to TxDP from the device M-Tx lane 0. 

5. Connect the Sublink 0 Tx_1N to RxDN from the device M-Rx lane 1.  

6. Connect the Sublink 0 Tx_1P to RxDP from the device M-Rx lane 1. 

7. Connect the Sublink 0 Tx_0N to RxDN from the device M-Rx lane 0.  

8. Connect the Sublink 0 Tx_0P to RxDP from the device M-Rx lane 0. 

9. Connect the UFS RST_N to the DUT reset signal 

10. If desired, connect the UFS REF CLK to the DUT ref clock input. 

See PROBING CONFIGURATION OPTIONS for more information on how to connect to the DUT. Refer to 

DEBUGGING INSTRUMENT CONNECTIVITY for more information on how to validate instrument connectivity. 

Step 2: Configure the exerciser/analyzer 
1. Select Exerciser + Analyzer or CTS mode on the toolbar 

2. Under Instrument Configuration select the desired memory Capture Options. 

3. Under Instrument Configuration set the Connected Link Width for each direction to x1 or x2. 

4. Under User Preferences determine if UFS packets are decoded when the trace capture is 

complete. 

Step 3: Configure Device Under Test 
1. Default device values are pre-set for the DUT in the Device Configuration tab of the Settings 

window, and CTS tests will poll the device for any required changes. If necessary, update the 

Device Configuration values for any settings that are unique to your device. 

2. A UniPro and/or UFS link connection between the exerciser and DUT is required for the exerciser 

to perform compliance/conformance (CTS) testing, corner case, margin or automated stress 

testing. Press the “Boot” button in the tool bar to boot the DUT. If UniPro is the Default Protocol 

in Settings->User Preferences->Display Preferences or is the selected Protocol in the Device 

Control section of the Configuration windows pressing “Boot” will initiate the Link Startup 

Sequence. If UFS is the selected protocol a boot will be completed including UniPro LSS and UFS. 

Step 4: Configure tests 
1. Go to the CTS Configuration or Exerciser & TV Configuration window. 

2. Select which Speeds, Link Widths and other device configurations to test. If testing UFS the 

appropriate LUNs must be selected. 

3. Select which test Categories and Tests to run. 
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Step 5: Configure stress testing 
Test Run Order controls the order in which tests are executed. 

1. Loop Order: loop order specifies the nested order of test execution.  Tests will be run from the 

bottom up, with all tests in each loop executed before the next higher loop is begun. So, if the 

Loop Order is Speeds, Link Widths, Tests then all Tests will be completed for a Link Width before 

being executed for the next Link Width, etc. The loop order can be adjusted by dragging categories 

up or down in the Loop Order box. 

2. Ascending, Descending, Random Seed: this specifies which order the tests are executed within 

the Loop. If Random Seed is selected a value can be entered to generate a random but 

reproducible test order based on the seed value. 

Step 6: Configure Run Control 
Test Run Control specifies the number of iterations of the test configuration to run, dictated by Test Run 

Order. Test execution will stop after the specified Number of Loops (outer loops on Test Run Control) or 

No Result Test Cases have occurred. 

The user can specify the number of test configuration loops to run OR the number of No Result Test Cases 

to allow before terminating the test run. When Number of No Result Test Cases field is blank or 0, tests 

are run for the given number of loops. If values are provided for both conditions, then tests are run until 

any ONE of the conditions is met. 

Step 7: Run the configured tests 
Press the Start or Start CTS button to run the configured tests, and watch the Results windows fill with 

Pass, Fail, Warning, or Info results. 
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Exerciser Compliance (CTS) Testing Files 
During the software installation process, 

you can elect to install the “TV and Stimulus 

Test Case Source Files”. These files contain 

the Stimulus and Trace Validation source 

for the UniPro 2.0 and UFS 4.0/3.1 Test 

cases. If you chose not to install the source 

files, you can still run the CTS Tests, but you 

will not be able to view the source. The CTS 

Specifications for UFS can be obtained from 

JEDEC and UniPro can be obtained from 

MIPI.  

The source files are placed in the following 

folder: 

<User>\Documents \Protocol Insight\Falcon\Settings\TestCases 

Stimulus files have the .pie extension and Trace Validation files have the .pitv extension. Both of these 

files can be viewed and edited in the Visual Studio software by clicking on Test Editor and Open File. You 

can also view the source by opening and extracting these files using 7-zip or Winzip, as they are 

compressed archives. For more information refer to the Stimulus Editor User Manual and the Trace 

Validation User Manual.  

 

Running concurrent instances of the application software 
Two instances of the application software can be used concurrently, however only one instance of the 

application can communicate with the analyzer hardware at a time.  If you attempt to start more than 

two instances of the application software concurrently you will see a message box informing you that only 

two concurrent instances are supported. 

When a second instance is started it will show "OFFLINE" in the title bar and its Connect button will be 

disabled. If you close the first instance, which has the Connect button enabled, the second instance 

remains an OFFLINE instance and to Connect to hardware you will need to start another instance to enable 

the Connect button. 

You can also start the application software by double-clicking on an .pitx file.  If the application is already 

running, it will start a second instance which will load the file. 

You can load the same .pitx file in two instances and, for example, view different areas of the trace side-

by-side in the two instances. 

 

  

https://www.protocolinsight.com/wp-content/uploads/docs/Falcon%20Stimulus%20Test%20Editor%20User%20Manual.pdf
https://www.protocolinsight.com/wp-content/uploads/docs/Falcon%20Trace%20Validation%20Editor%20User%20Manual.pdf
https://www.protocolinsight.com/wp-content/uploads/docs/Falcon%20Trace%20Validation%20Editor%20User%20Manual.pdf
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Navigating the User Interface 

Tool Bar 

 

The tool bar allows selection of analysis view modes and run control for the test executive and the analyzer 

and status update information: 

Modes (1) allow the user to select a set of three pre-

defined windows based on the instrument 

configuration and type of analysis being conducted 

(see WINDOWS below). 

Start (2) initiates Trace Validation, stimulus or test 

case execution for selected tests. Instrument status 

and settings (3) displays the status of the instrument 

hardware/software connection and opens the 

Settings tabs.  

Instrument status: 

    Red = software application is not connected to 

instrument hardware and the software is offline.  

    Yellow = software application is connected to the 

instrument hardware and the software is online. 

    Green = the instrument is connected and capturing 

traces 
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 Settings (3) configures user preferences, the instrument hardware, and the device under test (G550C 

only). Settings can also be accessed from the menu.  

Clicking on the Trigger or Filter buttons (4) will open the Trigger Setup and Filter windows. Choosing the 

 button will expand or collapse related task packets in the UFS Packet List window. See also Enable UFS 

Task Collapsing under FILTER WINDOW. 

By clicking Connect (5) the software will initiate connection with the hardware and go online. Clicking Start 

or Stop will begin or end a trace capture.  

The DUT status and control (6) indicators show the status of the DUT. One indicator is used for each 

direction of a link, so a x1 link will show two indicators and a x2 link will have four indicators.  Indicator 

colors are as follows: grey = not connected, yellow = device operating at PWM speeds, green = device 

operating at HS speeds. Clicking Boot will initiate a UniPro or UFS boot of the DUT. 

The application status bar (7) indicates progress during common activities such as file open/save and test 

case execution. Clicking the blue info icon (8) will open the APPLICATION STATUS window. 

Pressing cancel (9) will stop any background processes being performed, such as calculating Traffic 

Overview or Events, and can cancel test executive and trace validation execution. 

Custom toolbars (10) can be added to the main application, see USER TOOLBAR TAB for more information. 

Custom toolbars are added to the row below the factory default toolbar 

Windows  
Selection of one of three display modes (1 above), Analyzer, CTS, or Exerciser + Analyzer, will activate a 

set of pre-defined windows: 

Analyzer mode will open the Trace Validation Results and Traffic Overview windows, UniPro and UFS 

Packet List and Events windows, TV Configuration, Packet Decode and Data View. Instrument Status 

is positioned on the right side as a tab, and Simple Packet Search is a tab on the left side. 

CTS mode is only available on the Falcon G550C Exerciser. This selection opens the TV Results and 

Traffic Overview windows, the Packet List and Events windows, and Packet Decode and Data View. It 

also opens the CTS Configuration window to set up and run CTS test cases. The Stimulus and TV  

Exerciser + Analyzer mode opens the TV Results and Traffic Overview windows, and the UniPro and 

UFS Packet List and Events windows, Packet Decode and Data View. It also opens the Stimulus Results 

and Exerciser & TV Configuration windows. The Exerciser & TV Configuration window provides access 

to all configuration settings and the permits the running all tests, including differing stimulus and 

Trace Validation tests, in one single test run. This can result in the creation of one test result trace file 

with many types of link traffic. Available for the G550C only. 
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Figure 6: Exerciser + Analyzer window layout 

All windows are dock-able inside or outside of the application framework, using standard docking 

paradigms.  Windows can be restored to the default mode configurations by selecting View->Restore 

Default Layout from the main menu. 

Configuration window – Analyzer mode 

Device Control 

Protocol: Selecting either UniPro or UFS Protocol determines which tests are listed in the Tests section 

below. This also dictates the action of the Boot button on the toolbar. 

Validation Settings 

Debug Enabled: turns on Trace Validation test debugging. Messages that are generated by the Trace 

Validation test are output to the Trace Validation Results window to help users track progress in the Trace 

Validation analysis. See Debug under INTERPRETING TRACE VALIDATION RESULTS for more information. 

Tests 

Select the test cases to be executed. The following test categories are available for execution in Analyzer 

mode: 

UFS CTS Test Cases: The Test Cases in this category verify compliance to the UFS CTS. A Trace 

Validation result of “Pass” indicates the DUT meets the CTS Test Case criteria. In Analyzer mode these 

tests are run as Trace Validation tests against existing traces. 

UFS Debug: This category contains general UFS debug tests. 

UniPro CTS Test Cases: The Test Cases in this category test the DUT for compliance to the UniPro CTS. 

A Trace Validation result of “Pass” indicates the DUT meets the CTS Test Case criteria. In Analyzer 

mode these tests are run as Trace Validation tests against existing traces. 
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UniPro Debug: This category contains debug test cases to check UniPro behavior. For example, to 

verify that the Link Startup Sequence ran correctly. 

Search TVs: These Trace Validation tests can be used to search a trace for specific conditions. The 

application software library includes three search TVs, “Find UniPro Error Packets“, “Find UFS Error 

Packets” and “Find Protocol Insight CTS Markers”. 

The “Protocol Insight CTS Marker” is MIBAttribute 

0xFFFF. The device may report a ConfigResultCode of 

0x1. This is normal.  

Advanced Trigger Offline TVs: Advanced Triggers that have been defined with Test Editor can be run 

against any previously captured trace to find trigger events in existing traces, or to test newly 

constructed advanced triggers. If no Advanced Triggers have been defined this category won’t appear. 

Custom Tests: Custom test directories are displayed in italics at the bottom of the list; with Trace 

Validation custom tests shown in Analyzer mode. If no custom test cases exist in a directory the 

directory will not be displayed. The tests listed can be refreshed from the File menu as new custom 

test case are created. 

Configuration window – CTS mode 
 Available for the G550C only. 

Device Control 

Initiate Reboot Device Up Every Run: If this box is 

checked, the reset line (see line 9 of STEP 1: CONNECT ) is 

asserted and a UFS boot and/or UniPro Link Startup 

Sequence is executed before every test case. This should 

be used for early testing to verify the tests work with a 

known device state, once this has been verified it is 

recommended to deselect this option. 

Protocol: Depending on this selection, the test list in the 

Tests section of the Configuration windows is filtered for 

UniPro or UFS tests and the Configured LUNs section is 

hidden or displayed for device and run control choices. 

This selection also controls the action of the Boot button 

in the tool bar. The Boot button will either boot the device 

through LSS if UniPro is selected, or to UFS if UFS is 

selected. 

The primary (default) protocol for this selection can be set 

in Settings->User Preferences->Display Preferences 

Test Run Order 

Control the order in which tests are executed.  Run order is specified by Loop Order in Ascending, 

Descending, or Random Seed order.  See STEP 5: CONFIGURE STRESS TESTING for more information. 
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Test Run Control 

Specify the number of test cycles of the test configuration to run. Test execution will stop after the 

specified number of full test loops (outer loops on Test Run Control) or No Result Test Cases have 

occurred. See STEP 6: CONFIGURE RUN CONTROL for more information. 

Transmission Mode 

Controls Auto/NonAuto power modes during Test Run operation. 

Scrambling 

Enable or disable data scrambling during Test Run operation. 

Rate Series 

Enable or disable Rate Series A and/or B. 

Configured LUN 

If UFS Protocol is selected under Device Control in the Configuration windows or as the Primary (default) 

Protocol in Settings->User Preferences->Display Preferences, this section will be visible and is used to 

choose the Configured LUNs to control and test with test executive Run Control. 

All UFS tests in the Configuration windows are associated with a LUN. The tests that have a LUN value of 

255 correspond to the NONE (LU agnostic) selection in the Configured LUN selector. For requests that do 

not target a specific LUN (e.g. a Query Request with the Read Descriptor Opcode) the NONE LUN is used. 

The NONE (LU Agnostic) LU is specific to the Protocol Insight test Configuration windows, they aren’t 

mentioned in the UFS spec. Since every test is associated with a LU this is how to define a test that is LU 

agnostic. 

Speed 

Configure the speeds to be tested. 

Link Width 

Configure the link widths to be tested. UniPro and UFS widths up to x2 are supported. 

Validation Settings 

Debug Enabled: turns on Trace Validation test debugging. Messages that are generated by the Trace 

Validation test are output to the Trace Validation Results window to help users track progress in the Trace 

Validation analysis. See Debug under INTERPRETING TRACE VALIDATION RESULTS for more information. 

Tests 

Select the CTS test cases to be executed. 

Configuration window - Exerciser + Analyzer mode 
Available for the G550C only. 

This configuration window replicates all the functionality of the CONFIGURATION WINDOW – CTS MODE, with 

the following additions to the Tests section: 
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Tests 

The list of available tests can be filtered: 

 Selecting “All” will display all tests in the list, including Stim, TV and CTS tests. The type of test is 

identified by an icon as either a legacy Stimulus Builder test with a red , a Stimulus Test Editor test 

with an orange , a Trace Validation test , or a test containing both Stimulus and Trace Validation

. 

Selecting All permits the running of all tests, including differing Stimulus and Trace Validation tests, in 

one single test run, resulting in the creation of one trace result file with many types of link traffic and 

analysis. 

 Selecting “TV” will display only Trace Validation tests. 

 Selecting “Stim” displays only stimulus tests. 

Filter Linked Tests: Checking the “Filter Linked Tests” box when All is selected will filter the list and only 

display those tests that include both a Stim and associated TV test. Tooltips identify the Stim test linked 

to each TV test listed.  

Depending on the display mode selected the following test categories and tests may be available for 

execution in the Tests section: 

UFS CTS Test Cases: The Test Cases in this category test the DUT for compliance to the UFS CTS. 

Execution of the linked Stimulus with a Trace Validation result of “Pass” indicates the DUT meets the 

CTS Test Case criteria.  

UFS Debug: This category contains general UFS debug tests. 

UniPro CTS Test Cases: The Test Cases in this category test the DUT for compliance to the UniPro CTS. 

Execution of the linked Stimulus with a Trace Validation result of “Pass” indicates the DUT meets the 

CTS Test Case criteria.  

UniPro Debug: This category contains general UniPro debug test cases to check UniPro behavior. For 

example, to verify that the Link Startup Sequence ran correctly. 

Search TVs: These Trace Validation tests can be used to search a trace for specific conditions. The 

application software library includes three search TVs, “Find UniPro Error Packets“, “Find UFS Error 

Packets” and “Find Protocol Insight CTS Markers”. 

Advanced Trigger Offline TVs: Advanced Triggers that have been defined with Test Editor can be run 

against any previously captured trace to find trigger events in existing traces, or to test newly 

constructed advanced triggers. If no Advanced Triggers have been defined this category won’t appear. 

Custom Tests: Custom test directories are displayed in italics at the bottom of the list; if no custom test 

cases exist in a directory the directory will not be displayed.  Depending on the display mode selected, 

Stimulus and/or Trace Validation custom tests will be shown. The tests listed can be refreshed from the 

File menu as new custom test cases are created. 
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UniPro and UFS Packet List windows 
The Packet List windows display all packets in a trace. If Trace Validation is used, clicking on a result in the 

Trace Validation Results window will position the cursor in the Packet List window on the packet of 

interest in the test sequence.  

The information displayed in the Packet List can be changed by right-clicking in the column header bar 

and selecting different columns from the list available. 

 

Correlated views: The Packet List views can be locked so that the active cursor correlates to the same 

packet in each view. Clicking the Lock icon in the upper right corner of a List view will lock all windows, 

and a “Correlated” bookmark will identify the active cursor in each window view. 
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Color Coded packets: Common packet types in the list window are color-coded the same, for example, all 

End_of_Burst, PACP_SET_cnf or PACP_GET_cnf packets are of the same color. Color selections can be 

changed from the menu from Setting->Packet Display or by clicking the Settings icon on the toolbar. 

All error packets are highlighted in red. For more info about error packets see “What is the difference 

between Symbol Errors in the Instrument Status window and red error packets in the UniPro and UFS 

Packet listing windows?” in the app note PDF “App Note Tech Support FAQs”. 

Bookmarks can be added to any packet in a Packet List or Event view window by right-clicking and 

selecting Add Bookmark. By right-clicking and selecting Edit Bookmark an existing bookmark can be 

renamed or given a different color.  

Bookmarks can be used to add comments to traces in the Comments field. 

Comments are tied to a bookmark, which can be locked to a specific 

packet so it can’t be moved. All comments in a trace can be viewed in the 

BOOKMARK LIST WINDOW; if the comment has multiple lines the full 

comment is displayed in the tooltip when hovering over the comment: 

 

Hovering over a bookmark will display a tooltip indicating timestamp and delta time to 

other bookmarks. If Zero Time Stamp Here is selected, all timestamps are recalculated 

from the selected packet, with negative timestamps before and positive timestamps 

after that packet. Selecting Restore Original Time Stamp will reset the timestamps to the original values. 

Navigating a Packet List window can be 

accomplished in several ways activated by right-

clicking anywhere in a Packet List or Event 

window: 

Go To permits navigation to Start of Trace, End of 

Trace, last packet or bookmarks. 
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UniPro Events window 
The UniPro Events window contains four panes, the Overview, Detail, Link, and Sample panes, that allow 

drill-down from the full trace to the lowest level packet information: 

 

Overview pane 

The Overview pane, in the blue box, consist of two scatter charts (one for each direction) that represent 

each packet in the trace with its time position as a dot.  Since there are usually more packets in a trace 

than horizontal pixels in the view, each dot in the view will usually represent multiple packets.  

 

The numbers along the X-axis represent time since the beginning of the trace and each row along the Y-

axis represents a set of packet types. 
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The top row is the Speed row and is always present when any packet is present.  It is the only multi-color 

row, changing color when the speed changes.  The speed colors are: 

 

PWM-G0 x1, PWM-G0 x2, PWM-G1 x1, PWM-G1 x2 

 

PWM-G2 x1, PWM-G2 x2 

 

PWM-G3 x1, PWM-G3 x2 

 

PWM-G4 x1, PWM-G4 x2 

 

PWM-G5 x1, PWM-G5 x2 

 

PWM-G6 x1, PWM-G6 x2 

 

PWM-G7 x1, PWM-G7 x2 

 

HS-G1A x1, HS-G1A x2, HS-G1B x1, HS-G1B x2 

 

HS-G2A x1, HS-G2A x2, HS-G2B x1, HS-G2B x2 

 

HS-G3A x1, HS-G3A x2, HS-G3B x1, HS-G3B x2 

 

HS-G4 x1, HS-G4 x2 

 

HS-G5 x1, HS-G5 x2 
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Unknown speed 

The remaining rows are presented in this order: 

 

DataFrame_BadTC, AFCBadTC 

 

NAC 

 

DataFrame_TC0, DataFrame_TC1 

 

PACP_PWR_req, PACP_PWR_cnf, PACP_CAP_ind, PACP_CAP_EXT1_ind, PACP_EPR_ind, 

PACP_TEST_MODE_req, PACP_GET_req, PACP_GET_cnf, PACP_SET_req, PACP_SET_cnf, 

PACP_TEST_DATA_0, PACP_TEST_DATA_1, PACP_TEST_DATA_2, PACP_TEST_DATA_3 

 

AFC_TC0, AFC_TC1 

 

TRG_UPR0, TRG_UPR1. TRG_UPR2 

 

SOB, EOB, FLR, SKIP, PREPARE, SYNC, HIBERN8, BURST, SLEEP, STALL, LINE_RESET, LINE_CFG 

 

End of trace is marked with a white dot with a red border.  There can be multiple End_Of_Trace 

events. 
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In the Overview pane there are 3 special markers, B, E, and C, which are drawn above each direction chart.  

The orange color of the B and E markers correspond to the range in the orange Detail pane (see red arrows 

below) while the C marker is always light blue. Hover over a marker to see its long name and time: 

• B – Begin – Where the Detail pane Begins in the Overview pane 

• E – End – Where the Detail pane Ends in the Overview pane 

• C – Center – The location of the packet that is at the Center in all Event views 

Bookmarks (e.g. B1 and B2) are drawn below each direction and tie to the same bookmarked packets in 

the other display windows. If additional bookmarks are added by the user, they will also be displayed in 

all Events panes. If you hover over a bookmark it will display its time and the time to other markers. 

By clicking/dragging in the Overview pane or by moving the B/E markers or by selecting a button in the 

Zoom Tool Bar on the left the range that is displayed in the Detail pane below can be changed. The C 

marker moves to the center of the B/E range when you change the B/E range with any method: 
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Detail pane 

The Detail pane is similar in appearance to the Overview pane, but it displays only the range currently 

selected in the Overview pane.  It uses the same colors and row arrangement as the Overview pane.  A 

dot typically indicates multiple packets of the type for the row, but you can zoom in to a point where a 

dot represents a single packet. 

 

You can change the range that is displayed in the Link and Lanes panes, which are the panes below the 

Detail pane, by clicking/dragging in the Detail pane.   

In the Detail pane there are 3 special markers, LB, LE and C.  The LB/LE/C markers are not moveable.  The 

yellow color of the LB and LE markers correspond to the range in the yellow Link pane below, while the C 

marker is always light blue. Hover over a marker to see its long name and time: 

• LB – Link Begin – Where the Link pane Begins in the Detail pane 

• LE – Link End – Where the Link pane Ends in the Detail pane 

• C – Center – The location of the packet that is at the Center in all Event views 

The range of packets displayed in the Link pane below are indicated by the yellow LB and LE markers and 

with an area of shading in the Detail pane. 
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Link pane 

The Link pane creates an intermediate view between the Overview and Detail scatter charts and the byte-

detailed raw Lane and Sample panes.   

 

In the Link pane the X-axis is a modified time scale.  A packet time may be so small in comparison to a 

Sleep that a true time scale for the packet would be less than a pixel in width, and the packet “rectangles” 

appear as a line with a minimum width.  Events are shown on a separate row from Packets.  Where 

possible, packets are grouped together to make a single rectangle.  The tool tip for the rectangle shows 

the packets and time that the rectangle represents. 

In the Link pane there are 3 special markers, LB, LE and C.  The LB/LE/C markers are not moveable.  The 

green color of the LB and LE markers correspond to the green Lane pane below, while the C marker is 

always light blue. Hover over a marker to see its long name and time: 

• LB – Link Begin – Where the Lane pane Begins in the Link pane 

• LE – Link End – Where the Lane pane Ends in the Link pane 

• C – Center – The location of the packet that is at the Center in all Event views 

The range of packets that are displayed in the Lane pane are indicated by the green LB and LE markers. 
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Sample pane 

The Sample pane shows byte level detail for the first 2 billion samples.  The X-axis is based only on the 

width of the displayed bytes, it is not time-based, and the only time component is the displayed time. The 

packets in the two lanes are interleaved to show their Packet Index order.  

The higher level panes in Events (Overview, Detail, and Link) display decoded packet data from the UniPro 

Packet List window.  In contrast the Sample pane is built from the raw trace data. 
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UFS Events window 
The UFS Events panes are very similar to the UniPro Events panes. See UNIPRO EVENTS WINDOW for more 

information. An important difference is that in UFS Events, each row represents a single packet type. 

There are many possible packet types in UFS but in practice a trace tends to contain a subset of all the 

possible packets that could be displayed. By dragging the blue bar at the bottom of the Detail pane the 

scatter chart height can be increased to display more packet types. 

 

The Detail pane is a zoomed view of the Overview chart that works just like the UniPro Events pane: 

  

This chart is sized larger because packet level details will be more important to users in this view.  
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In both the Overview and Detail panes the packet colors are the same as in the UFS Packet List window 

and can be changed from the Settings menu: 

 

The Link panes are similar to the Link panes in UniPro Events.  The important difference is that rather than 

having an Events time row, they have either a Request or Response packet row, depending on direction: 
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Packet Decode Window 
To display the protocol decode of a packet of interest in the Packet 

Decode window, click on the packet in the appropriate Results 

window or in a Packet List window. Hovering over a bit displays 

additional decode information. Selecting 8, 16, or 32 defines the 

bit width of the display. 

Data View Window 
The Data View window displays the entire packet, including header 

and payload for a selected packet. While the first 160 bytes of data 

are fully decoded in the Packet Decode window, the remainder of 

the packet payload is displayed in the Data View window only. Up 

to 16 bytes can be displayed per line.  

By right-clicking anywhere in the Data View window the user can 

choose from several options to copy the data for pasting into other 

applications. 

Trace Validation Results Window 
Since CTS test cases use the 

Trace Validation engine for 

protocol sequence and packet 

inspection, the Trace Validation 

Results window is used in the 

Analyzer, CTS and Exerciser + 

Analyzer modes to display test 

or analysis results.  

The TV Results window allows 

extensive quantitative analysis 

of results data.  Results can be 

grouped and summarized, 

sorted, and filtered by any 

header column. To turn on or off 

a column, right click in the 

column header area.  

Key words can be searched from 

the Search bar. 

To group and summarize, click on any column header and drag into the Test Results field. This will 

summarize the results with an item count of occurrences.   

Clicking on a TV Results message in the Results window will center that packet in the Packet List and Packet 

Decode windows for further analysis. 
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Traffic Overview Window 
Traffic Overview offers a summary of all packets found in the 

trace. Any packet can be found by selecting that packet type in 

the Traffic Overview window, clicking on either Host, Device or 

Total, and clicking the up or down buttons to go to the next or 

previous packets, or <| and |> to go to the first or last packets. 

Stimulus Results Window 
The Stimulus Results window provides success/fail information 

on the stimulus test cases executed. This window does not 

display analysis results but only whether the stimulus test ran 

successfully. Information in this window is not saved with the 

File->Save function. 

Message Console 
Messages generated by the NLog debug logging tool 

are automatically sent to the Message Console. These 

are the same messages that are stored to the NLog 

default log file at C:\Users\[user name]\AppData\ 

Local\Protocol_Insight\Falcon\Temp\logs\logfile.txt.  

Messages output from Stimulus Editor can also display 

in the Message Console if implemented by the user. 

The NLog messages can be disabled by unchecking 

"Show Log Messages".  

 

Simple Packet Search Window 
Simple Packet Search will search any sublink for any packet type, 

packet header or payload value. Under “Search Options”, “From:” 

dropdown, you can select: Begin, one of your bookmarks or Trigger 

as the starting point for the Search. The “Search” button will always 

search forward from the “From:” selection, and is the only button 

affected by the dropdown setting you select.  

You can mouse over the search 

buttons to see a pop-up definition 

on how they function. 

  “Find the First Packet” 

  “Find the Previous Packet” 

  “Find the Next Packet” 

  “Find the Last Packet” 
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To define your search criteria, select any active packet from the list in “Select Event for Search from this 

List” sub-window and use the Search Options to navigate through packets that meet the search criteria. 

Active packets will be white and not greyed out as shown in the example below. 

Double-clicking on the packet type of interest will bring up the Packet Editor (the same used for Simple 

Trigger) to edit the header or payload values to search for. These packet values can be saved as Favorite 

Packets for later re-use with either Simple Packet Search or Simple Trigger.  

Until the Traffic Summary calculations are complete, the Simple Packet Search cannot be used as 

the available packets will not be populated in the search list. 

In the example below we search on the QUERY RESPONSE (READ FLAG) packet and look for Task Tag “1A”. 

 

 

 

 

 

 

 

 

 

 

 

If you want to search from the end of the trace backwards, in the trace you can right-click and select “Go 

To End of Trace”. Then you can use the arrow button “Find the Previous Packet” to locate the first packet 

from the 

End of the 

Trace. 
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Bookmark List window 
The Bookmark List window will display all bookmarks in the trace, with the timestamp, delta time to every 

other bookmark, and comments. Right clicking within the list will enable navigation to any bookmark in 

the trace. The Bookmark List window can only be accessed from Menu->View->Bookmark List. 
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Trigger Setup Window 
The Trigger Setup window is accessed from the Tools 

menu. The Choose Trigger dropdown allows selection of 

different trigger actions, shown to the left. The selections 

you choose in this menu will affect how the data captured 

into the capture memory appears. 

To begin capturing data or attempting to trigger you must click Start. After pressing Start the analyzer 

captures data and it is written into the capture memory. The base instrument configuration has 8GB of 

capture memory, but this can be 

extended up to 30GB. Refer to Hardware 

Specifications INSTRUMENT for more 

information.  If a trigger case is not 

found, the capture memory will 

continue to fill. Once the capture memory is full, the oldest captured data will be dropped, and new data 

will continue to be stored. This process continues until a trigger condition is met or the Stop button is 

clicked.  

Trigger Selections 

No Trigger will cause the analyzer to continue to store data until the Stop button is clicked.  

Trigger Immediate will cause the analyzer to immediately trigger and start filling the capture memory. 

The analyzer will stop capturing when memory is full, or the Stop button is clicked. 

Simple and Advanced Triggers will cause the analyzer to start filling the capture memory. The analyzer 

monitors all sublinks for any packet type, packet header or payload value and will generate a trigger 

when the criteria are met. The analyzer will stop capturing when the capture memory is full, or the Stop 

button is clicked.  

 

Trigger Position 

The Trigger Position is used to set how much capture memory is reserved to save trace data prior to the 

trigger event versus after the trigger event. Below are a few examples of trigger position and the effect 

this has on capture memory and display. 

Case 1: 95% pre-trigger and 5% post-trigger 

In this case the 95% of the capture memory 

will contain pre-trigger packets (orange) and 

5% of the capture memory will have post-

trigger packets (green).  
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Case 2: 50% pre-trigger and 50% post-

trigger 

In this case the 50% of the capture memory 

will contain pre-trigger packets (orange) and 

50% of the capture memory will have post-

trigger packets (green).  

Case 3: 20% pre-trigger and 80% post-

trigger 

This allocates 20% of the capture memory 

for pre-trigger data and 80% for post-trigger 

data. If the trigger event occurs with at least 

20% of the capture memory full, then all the 

capture memory will be used. However, should the trigger event occur prior to 20% of the capture 

memory filling, the entire capture memory buffer will not be used. In this example the figure illustrates a 

trigger occurring at 5% capture memory filled when the position was set to 20%. The capture memory will 

contain 5% pre-trigger packets (orange), 80% post-trigger packets (green) and 15% will be unused (red). 

The user can adjust the trigger position accordingly to make full use of the capture memory.  

Simple Trigger 

To set a Simple Trigger select Use Simple Trigger 

from the Choose Trigger dropdown. Double click 

on the packet of interest from the left-side 

packet list and it will appear in the right-side 

“Trigger on any of these Events” area. 

Alternatively, the packets can be 

dragged/dropped. If multiple packets are 

chosen, the trigger machine will use OR logic. 

Double-clicking on a packet in the “Trigger on 

any of these Events” area will bring up the 

Packet Editor (the same used for Simple Packet 

Search) to edit the header or payload values to 

trigger on. These packet values can be saved as 

Favorite Packets for later re-use with either 

Simple Trigger or Simple Packet Search. Simple 

Triggers can also be saved as Favorite Simple 

Triggers for future use. 
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Advanced Trigger 

See the Advanced Trigger Editor User Manual for details on how to construct an advanced trigger. 

 

Advanced Triggers are created and edited using the Test Editor, which can be accessed from the Tools 

menu or by selecting Advanced Trigger from the Choose Trigger dropdown in the Trigger Setup window 

and clicking New or Load.  

Once created, Advanced Triggers are automatically added to the list of available triggers in the left pane 

of the Advanced Trigger tab. Clicking Refresh will update the list of available Advanced Triggers. To set an 

Advanced Trigger, double click or drag the trigger of interest from the left pane into “Drag Advanced 

Trigger Here” in the right pane. 

Advanced Triggers that were saved and loaded from a .pitx trace do not include the full .piat Advanced 

Trigger information. Therefore, they are not editable. These are listed in yellow with a ToolTip "This trigger 

is not editable". To modify a non-editable Advanced Trigger the user must open the .piat file in the 

\AdvancedTriggers directory. 

The TRIG IN connector (trigger in) on the instrument front panel (see EXERCISER/ANALYZER FRONT PANEL - 

FALCON G500C/G550C) can be used with other packet events and is selected in the Analyzer Resource. 

TRIG IN is available in the Simple Trigger window or Advanced Trigger Editor. Once a rising edge is detected 

on TRIG IN, the trigger event will occur on the next packet. When a trigger event has occurred, a TRIG OUT 

is asserted on the front-panel TRIG OUT connector.  
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Filter Window 
The Filter window, accessed from 

the Tools -> Filter menu or from the 

Tool Bar , permits the filtering of 

specific packet types either before 

or after the trace has been stored 

and saved. 

The Pre-Capture Hardware Filter 

can eliminate Fillers, Skips, Start of 

Bursts, End of Bursts and AFC_TC0 

packets. The L2 Message Payload 

filter keeps the first 272 bytes of 

the Message (a Message is the 

UniPro packet containing a UFS 

packet) and removes the remaining 

contents of the packet. 

Since these are filtered out prior to 

trace capture they are not stored or 

saved with the .pitx trace. 

Packets can still be used as a trigger 

resource even if that packet is 

filtered out with the HW filter.  This 

is because the trigger engine is 

before the filter block. 

Post-Capture Software Filter will capture and store all packets, but it will suppress the selected packet 

types from the List window. The Traffic Summary window will still display all packets but highlight and 

deactivate those that have been filtered. 

If Traffic Overview, Simple Packet Search or Bookmark navigation is used to go to a software filtered 

packet the active packet displayed will be the packet just before the filtered packet. In TV Results the “In 

Test” markers will disappear with the filtered packet and the user won’t be able to go to those filtered 

packets. Simple Triggers can still be constructed with Filter enabled; if the trigger packet is filtered out the 

Trigger bookmark will mark the closest unfiltered packet prior to the trigger event. 

If the Enable UFS Task Collapsing box is checked the UFS Packet List window will suppress all related task 

packets associated with a UFS Command packet. This can also be enabled from the Toolbar. 
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Settings Window 

The Settings window is accessed from the Settings menu or the settings icon  on the toolbar. The 

Settings window has separate tabs for User Preferences, Instrument Configuration, Device Configuration, 

Database Configuration, Packet Display, User Toolbar, Smart Tune Equalization and Advanced Settings. 

Settings can be customized for each tab and saved and loaded from files located at <User>\Documents 

\Protocol Insight\Falcon\Settings. Customized settings for a given tab are saved to a .set file. These files 

can be copied so that users can carry their own personal configuration setting with them from PC to PC.  

Note that all settings in the Settings tabs except for User Preferences and User Toolbar are saved with the 

trace when File->Save is used, and when a trace is opened the settings saved with the trace will override 

the settings in the Settings window. This allows the user to preserve the exact settings used when the 

trace was captured. 

User Preferences Tab 

User Preferences allows the user 

to tailor their experience and 

optimize application software 

performance based on their 

typical application and most 

common use models. For 

example, a user who is primarily 

interested in using the listing 

window to debug UniPro may 

choose to set the default mode 

to Analyzer, turn off automatic 

decode and calculation of UFS 

packets, and set the default 

Packet Listing Window and 

calculation settings exclusively 

for UniPro. 

Display Preferences 

Setting the Initial Mode controls 

which display mode is active 

when the software application is 

launched (see WINDOWS for 

more information). The Primary 

Protocol controls whether UFS 

packets are decoded (if selected in Calculation Preferences), what the default protocol is for the device 

Boot/Reboot button in the toolbar, and the selected test list under Device Control in the Configuration 

window. The Active Packet Listing Window sets the default Packet List window, for example selecting 

UniPro will cause the UniPro Packet List window to be the active Packet List window upon completion of 

a trace capture. 
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Correlate Scrolling in Packet Lists locks the UniPro and UFS List windows by default when scrolling. 

Number Display makes large numbers more readable if the Formatted box is checked. It adds comma 

separators before the decimal place and spaces after every three digits or every four hex values. This 

applies only within the GUI and does not affect exported data. 

Calculation Preferences 

After the instrument has captured a trace it is off-loaded to the application software and the UniPro 

Packet List, Packet Decode and Data View windows are immediately populated with decoded trace data. 

The UFS Packet List, Packet Decode and Data View windows are also populated with decoded UFS data if 

the Decode UFS box is checked under Calculation Preferences.  

Background calculations then are initiated to update the UFS Traffic Overview, Events windows and 

Sample List if those boxes are checked in Calculation Preferences.  

The background calculations can take time and during background calculation you cannot save the trace 

file unless you cancel calculations from the toolbar. To disable automatic background calculation of some 

or all of the automatic calculations deselect those under “Calculation Preferences”. 

If a trace has been saved without completing some or all calculations, when the file is re-opened, it will 

automatically start calculating in the background if a box is checked under “Calculation Preferences”. 

You can force a calculation of an uncalculated trace by selecting Calculate Options from the Results menu. 

The application software will still be highly responsive while it is doing background calculation, and Packet 

List, Packet Decode and Data View windows are fully functional. However, until Traffic Overview is 

calculated the Simple Packet Search functionality will not be available. 

Show Warning Dialog On These Events 

This section can be used to change warning dialog preferences if the “Do not show this message again” 

box has been checked in any warning dialog. 

For example, the Save Configuration and Data 

warning dialog will appear anytime the 

following actions are performed: opening a 

new trace file, exiting the application, starting 

the analyzer, clearing results and data, clearing 

Trace Validation results, or running tests. 

Temporary Directory Path 

When unloading trace data from the instrument to the application software, large files are temporarily 

created that can grow to be 5-10x larger than the actual .pitx file. This can affect the performance of the 

application if the target directory is located on a drive that has slower write speeds and/or insufficient 

disk space.  

The path where these temporary files are stored can be changed to point to another location, typically a 

faster larger drive. 
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Instrument Configuration Tab 

This tab is used to configure the Falcon instrument. To display status information about the analyzer and 

exerciser instrument and UniPro link see the INSTRUMENT STATUS WINDOW. To configure analyzer and 

exerciser tests see the CONFIGURATION WINDOW. 

 

The Reset Analyzer button will reset the exerciser, analyzer and tracking state machines. The PHY will be 

reset only if the analyzer detects it is in an indeterminate state.  

In the Host and Device sections the Sublink 0 Label and Sublink 1 Label can be changed to reflect their 

connection. Lane 0 and Lane 1 for each of the sublinks must match the physical mapping on the test 

system.  
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The ability to change the lane mappings in software is allowed for debugging only. Improper 

operation may result if the physical lane mapping is not maintained.   

The setting for UniPro Version instructs the instrument to decode packets according to specification 

version 1.8 or 2.0. 

The sync length filter should be set to the minimum allowable length or larger, refer to the INSTRUMENT 

section, DUT Requirements.  

Smaller values may be used, and this may improve link acquisition time. However, the analyzer 

may not reliably acquire the link or display erroneous data when using values under minimum 

specifications.  

Capture Options 

Capture Options are used to define where traces are stored during capture. Choosing Standard will store 

the trace in instrument memory, up to the maximum amount specified in the Instrument Memory Depth 

field. Once the specified amount of memory has been filled, the oldest data will be discarded, and capture 

will continue with a circular buffer until the analyzer is stopped or a trigger event occurs. 

Choosing Streaming will immediately output the trace via the Thunderbolt3 interface and store the data 

on the controller PC hard drive. The size of the capture can be defined. Once the Disk Buffer Limit has 

been reached, the oldest data will be discarded and capture will continue with a circular buffer if Wrap 

Buffer is selected, otherwise the capture will stop. Note that streaming capture requires HW filtering of 

fillers, skips and UFS TC0 message payload to ensure optimum bandwidth. 

With streaming capture the entire trace is stored to disk before any processing, so if there is an error 

during processing the trace is still on disk and the "Save debug File" will save the whole trace. If there is 

an error during capture the trace will be lost. 

Streaming Performance Test evaluates the Thunderbolt3 and host PC performance for the two 

fundamental functions required for streaming: interface Bandwidth from instrument to the PC and Disk 

Write bandwidth. 2100MB/s is considered the minimum, any test not achieving this speed is evaluated as 

failing. See APPENDIX F: STEAMING CAPTURE for more details on how streaming capture works, and 

APPENDIX 2: SYSTEM REQUIREMENTS for a description of the minimum PC requirements for streaming 

capture. 

Other Settings 

Selecting a UFS clock with the Output Clock selection is only necessary if you are using the UFS external 

reference clock signal on the front panel of the instrument. 
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Device Configuration Tab (G550C Only) 

 

The Device Configuration tab allows configuration of the device parameters necessary for CTS testing.  

Beginning with v2.2.1 most of the device parameters are now queried from the device directly by the CTS 

test case and, if necessary, correct updated values are sent to the device.  The device parameters that 

must still be set manually are  

• UFS Device: 

o Enable Write Once Attribute Test Cases: Enables CTS test cases that write a Write Once 

Attribute, this prevents users from accidentally writing these attributes. 

o IMMED Supported: the device supports IMMED flag 

• UFS LUN Configuration: 

o Control Extension Mode Subpage Supported: The device supports the Control Extension 

Mode subpage 

o Mode Select Command Support PF=0: The device supports the Mode Select Command 

with PF=0 

To change UFS LUN Configuration for multiple LUNs, hold the shift key while selecting LUNs from the list 

on the left side in UFS LUN Configuration. 

When a trace file is saved as a .pitx file, the device configuration information is saved with the 

file. After opening a .pitx file, if changes are made to the device configuration using the Device 

Configuration window, these changes will overwrite the settings in the trace file. 
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Database Configuration Tab 

The Database Configuration tab is used to update and save settings to repair the SQL database. See 

APPENDIX A: RESETTING YOUR SQL DATABASE  thru APPENDIX C: MANUALLY INSTALLING MICROSOFT SQL 

SERVER for more information on how to configure the SQL database using this tab. 
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Packet Display Tab 

This tab allows the user to customize most packet colors used in the List and Event views. 
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User Toolbar Tab 

The factory default is directly underneath the Menus and is show below. Toolbars in the application can 

be move by left clocking and dragging the nine dot line to the left of the toolbar. 

 

 

Custom toolbars are added to the row directly below the factory default toolbar.  

 

To add items, select Settings→User Toolbar and choose the items you want to add. 

 

To restore the original toolbar configuration, choose View→Restore Default Layout. 

  

Factory default toolbar 

User toolbar 

Nine dot line 
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Smart TuneTM Equalization Tab 

Default ATT (Attenuation), VGA (variable-gain amplification), CTLE (continuous time linear equalization), 

and DFE (decision feedback equalization) settings are loaded into instrument hardware when the 

application software initially connects to the Falcon instrument.  

At the top of the Settings window, shown in red below, default recommendations for Probes and 

Accessories can be applied. Select and click “Appy Recommendation”. 

In some instances, acquiring the signal from the DUT can be problematic when test fixture trace routing 

or the cabling required to connect to the test fixture causes poor signal integrity or probing issues. To 

optimize signal acquisition in the case of poor signal integrity or probing issues the Falcon Series offers 

Smart Tune™ Equalization capability. Smart Tune allows the user to choose between manually setting 

fixed equalization values for the front-end PHY, auto equalizing using the M-PHY4.1/5.0 ADAPT capability 

or running auto equalization continuously each time a Burst is opened on the link.  

Access the Smart Tune™ settings by clicking on Settings, Smart Tune Equalization. 
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To set equalization values manually individual values can be entered in the Sublink 0 and Sublink 1 

Initial/Fixed Equalization Values section or saved values can be loaded from a file. Since the mapping of 

each of the PHY equalization settings to a physical parameter is complex, manual entry of values should 

only be done on the advice and recommendation of Protocol Insight Support.  

To run Auto Equalization using the MPHY ADAPT sequence check the box Enable Auto Equalization using 

the MPHY ADAPT sequence, then execute a Link Startup Sequence on the DUT and run the ADAPT 

sequence between the Host and Device. Return to the Equalization tab and click “Get Results”. Verify that 

a successful Smart Tune was achieved, see Verifying Smart Tune Results section. If successful, Smart Tune 

can safely be left with Enable Auto Equalization using the MPHY ADAPT sequence checked, in this mode it 

will equalize every time ADAPT is ran. Optionally, the results can be saved and used as fixed values, see 

the Saving and Applying Results section. If the Smart Tune was unsuccessful, see Verifying Smart Tune 

Results section, try repeating the entire process by running the ADAPT sequence again. If the Smart Tune 

results continue to be unsuccessful refer to the Troubleshooting Auto Equalization using the MPHY ADAPT 

sequence section. Note that because ADAPT is only supported in M-PHY 4.1 and 5.0 for HS-G4 and HS-G5, 

this capability does not support lower HS speeds. 

Troubleshooting Auto Equalization using the MPHY ADAPT sequence: These troubleshooting 

instructions are intended for Analyzer mode.  

• If the results show Abort > 0 and Done == 0:  This indicates that PHY is not seeing enough symbols 

to complete a Smart Tune. Verify that the Host and Device ADAPT sequence length is long 

enough, Falcon has a RX_HS_ADAPT_LENGTH_COARSE_Capability value of 0x91 (course,17), thus 

the Host and Device must both use an ADAPT_length of 0x91. If either Host or Device is does not 

use an ADAPT_length of 0x91 you can change the value after Link Startup but before the power 

mode change. Set the attribute PA_PeerRxHsAdaptInitial (0x15D3) to 0x91 in both the local and 

peer DME’s.  

• If the host and device ADAPT sequences length is long enough but still Abort > 0, it could be 

caused but the PHY falsely detecting a Tail of Burst to soon. Select the Enable TOB Filter, start 

with the default value of 0x100000 for symbols to ignore.  You can increase or decrease the 

symbols to ignore based on the ADAPT length. If you continue to have issues you can try Auto 

Equalization continuously or contact Protocol Insight Support with traces that show link startup, 

power mode change and the ADAPT sequence. Also take screen captures of the Equalization 

Results after each attempt. 

To run Auto equalization continuously select Enable Auto Equalization continuously. Then execute a Link 

Startup Sequence on the DUT and change power mode to the fastest mode supported and begin sending 

a good equalization data pattern.  To achieve the best results Smart Tune typically requires ~10MB of 

random data to be sent in a single burst. The recommended way to send random data for Smart Tune is 

in fast mode with scrambling enabled, because scrambled fillers are a pseudorandom data pattern. Verify 

that the analyzer is seeing data by observing the Hardware Counters increasing in the Instrument Status 

window. Return to the Equalization tab and click “Get Best EQ Values”. This will determine the maximum 

FOM value by observing equalization results for 5 seconds, then it will save the equalization values with 

the best FOM Quality. Once completed you should observe successful results, see Verifying Smart Tune 

Results section. If successful, the results should be saved and used as fixed values, see the Saving and 

Applying Results section. Auto Equalization continuously mode should only be used to get equalization 
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results and it is not recommended to leave Smart Tune in the Auto Equalization continuously mode. This 

capability supports all HS speeds. 

The Equalization Results section shows the value of the equalization settings that are currently being 

applied in the PHY. When running Smart Tune equalization, the PHY will try to find the ideal equalization 

values (ATT, VGA, CTLE, DFE). The status information (FOM (Figure of Merit), Abort, Done) will indicate 

the quality of the Smart Tune equalization. The Done counter indicates how many times equalization 

tuning successfully completes. When running Smart Tune this counter should increment every time a new 

Smart Tune is ran.  The Abort counter indicates how many times equalization tuning fails, failures typically 

occur because the PHY did not see enough bytes of data in a single burst, typically ~10MB are required to 

be sent in 1 burst for the PHY to correctly equalize. The FOM value indicates how good the equalization 

values are. The larger FOM value the better the equalization is, see Table 1 below for FOM Value to FOM 

Quality mapping. Poor FOM Quality typically indicates poor signal integrity which results in errors being 

captured. The FOM value is the perceived quality of the equalization, the only definitive test is if the RX 

can capture error free. There are instances where the FOM is a false large value, meaning the FOM Quality 

is a Good value but errors are still captured. This typically happens when the data pattern that was used 

for tuning is not random data, FILLERS that are NOT scrambled is the worst data for Smart Tuning.  

Verifying Smart Tune Results: A successfully Smart Tune is indicated by the Done counter value >= 1, 

values for all the PHY values should have changed from the previous value and the Figure of Merit value 

(FOM) should be Good quality, see TABLE 2. 

• Successful Smart Tune is indicated by (Done >= 1 and FOM Quality = Good) 

• Failed Smart Tune is indicated by (Done == 0 and Abort >= 1).  

• Poor quality Smart Tune is indicated by (Done >= 1 and FOM Quality = Poor). 

• Smart Tune did not run if Done == 0 and Abort == 0. 
 

FOM Quality FOM Value 

Good >=0x60 

Poor <0x60 & >= 0x50 

Bad <0x50 
Table 2 FOM Value to FOM Quality Mapping 

Saving and Applying Results: To save the values select “Copy Results to Fixed Equalization Values” to load 

the values into the PHY and switch to Fixed Equalization mode by unchecking the Enable Auto Equalization 

using the MPHY ADAPT sequence and Enable Auto Equalization continuously. 
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Advanced Settings Tab 

The Advanced Settings tab requires expert knowledge of the instrument, the Device Under Test 

(DUT) and test fixture configurations. The Advanced Settings tab should only be used on the 

advice and recommendation of Protocol Insight Support. Before beginning the user must 

acknowledge this by checking the box that “I understand how to use Advanced Settings”. 

The Reset PHY button will reset the M-PHY layer and write all values in the Smart Tune™ Equalization 

tab into the PHY register.  

 

 For information on how to use the Advanced Settings tab contact your local Protocol Insight 

representative or support@protocolinsight.com. 

mailto:support@protocolinsight.com
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Instrument Status Window 
This window is used to display status information about the analyzer and 

exerciser instrument and UniPro link operation. To configure the 

instrument, refer to the INSTRUMENT CONFIGURATION TAB under Setting on 

the menu. To configure analyzer and exerciser tests, refer to the 

CONFIGURATION WINDOW.  

The Analyzer section of Instrument Status is used to display analyzer and 

trigger status and the configured analyzer memory Capture Options. 

Analyzer Memory is displayed if Standard is selected as the Capture Type, 

in Settings window, Instrument Configuration tab, Capture Options. The 

amount of embedded Instrument Memory Depth selected is displayed, 

along with a percentage representing the amount of memory filled.   

The analyzer always reserves the amount of memory after the trigger that 

is set with the Trigger Position. For instance, if a 20% trigger position is set 

the analyzer will reserve 80% of the memory for post-trigger fill. What this 

means is that if the trigger occurs deep in the trace, then 100% of the 

memory buffer will fill, 20% before and 80% after. But if the trigger event 

occurs very early in the trace, say after only filling 5% of the total memory, 

the capture will total less than 100%. This is because 5% will be before the 

trigger and 80% after the trigger, totaling 85%. See TRIGGER SETUP 

WINDOW for more information. 

The Link Power Mode section provides real-time link status and power 

mode information. 

The Hardware Counters section provides insight into the real-time traffic 

on the link by counting the number of M-PHY symbols and symbol errors 

observed on each sublink/lane. Symbol errors in the Instrument Status 

window are KCode raw bit capture errors, typically caused by signal 

integrity problems, probing issues or M-PHY issues. The Hardware 

Counters will increment independently of if the analyzer Run button is 

selected. 

Streaming File Usage is displayed if Streaming is selected as the Capture 

Type in Capture Options in the Instrument Configuration tab. Streaming 

File Usage shows the amount of Disk Buffer Limit allocated and the 

percentage of that buffer that has been filled by the capture. Streaming 

Buffer Usage displays a graphical representation of the amount of the 

instrument’s embedded memory and the controller PC’s RAM that is 

being used as a buffer as the trace is being written to the Streaming File 

on disk. See APPENDIX F: STEAMING CAPTURE for more information. 
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Application Status 

The Application Status window can be accessed from the toolbar by clicking on the blue info icon to the 

right of the application status bar in the Tool Bar.  

The Application Status window will display progress on any computationally intensive functions being 

performed by the application, such as file opens, Traffic Overview and Events indexing, zooms, searches, 

and Trace Validation runs.  

If the Application Status window is opened before a Configuration/Analyzer Capture file is opened the 

status window will display all computations while the trace file is being opened. 

Application Status messages will be automatically cleared when a new trace is captured or loaded from a 

file. 
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Menu Functions 
Many menu functions are duplicated on the easy to access TOOL BAR. This section provides additional 

detail for the more complex functions. 

File Menu 
All trace data, including trace indexing for Traffic Overview and Events window, Trace Validation results, 

and any settings from the Configuration windows are saved in a file with file extension of .pitx (Protocol 

Insight Test). 

→Open Configuration… 

This function is used to open a previously saved .pitx configuration file to restore all of the Settings dialog 

configurations except User Preferences and User Toolbar. 

File→Open Configuration/Analyzer Capture… 

This function is used to open a previously saved .pitx file including the instrument and device 

configuration, the trace capture, trace indexing for Traffic Overview and Events views, and Trace 

Validation results. 

File→Open Recent Configuration/Analyzer Capture… 

This function is used to open recently used traces and/or configuration files. 

File→Save or Export Trace 

With this dialog the user can chose between saving a .pitx trace or a CSV export. When saving a trace the 

user can select what data to include in the trace and the level of compression. Default saves all trace data 

and the settings in all Settings dialog tabs except for User Preferences and User Toolbar. 
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File→Refresh Advanced Trigger Tests 

Updates the list of advanced triggers in the Advanced Trigger window with the advanced triggers in 

<User>\Documents\Protocol Insight\Falcon\ AdvancedTrigger. 

File→Refresh Trace Validation Test List 

Updates the list of Trace Validator test categories and custom Trace Validator test cases in the 

Configuration windows from the categories and test cases in <User>\Documents\Protocol 

Insight\Falcon\CustomTests. 

Directories in <User>\Documents\Protocol Insight\Falcon\CustomTests are displayed in italics as 

categories in the Configuration window test lists, appended to the bottom. For example, the directory 

<User>\Documents\Protocol Insight\Falcon\CustomTests\ProjectX would appear in the test lists as the 

category ProjectX. Custom tests must be saved in categories (sub-directories). New categories can be 

created by adding new sub-directories in <User>\Documents\Protocol Insight\Falcon\CustomTests with 

File Explorer. 

File→Refresh Stimulus Test List 

Updates the list of custom stimulus test categories and custom stimulus test cases in the Configuration 

windows from the categories and test cases in <User>\Documents\Protocol Insight\Falcon\CustomTests. 

Directories in <User>\Documents\Protocol Insight\Falcon\CustomTests are displayed in italics as 

categories in the Configuration window test lists, appended to the bottom. For example, the directory 

<User>\Documents\Protocol Insight\Falcon\CustomTests\ProjectX would appear in the test lists as the 

category ProjectX. Custom tests must be saved in categories (sub-directories). New categories can be 

created by adding new sub-directories in <User>\Documents\Protocol Insight\Falcon\CustomTests with 

File Explorer. 

File extensions: 

Here is a complete list of all file extensions: 

Traces (including the configuration & analyzer captures)  *.pitx 
 
Settings   
  Settings (for a given tab in the settings windows)  *.set: 
    Advanced.set 
    SmartTune.set 
    Device.set 
    Instrument.set 
    PacketDisplay.set 
    UserPreferences.set 
    UserToolbar.set 
    Default settings for each tab are stored in a file with the same name but with a .dft extension. 
 
  These individual Settings file extensions used prior to 2.4.0.10628 are still supported: 
    User Preferences  *.prf 
    Instrument Configuration  *.ins 
    Device Configuration  *.dev 
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    Database Configuration  *.dbc 
    Packet Display  *.pcl 
    User Toolbar  *.utb 
    Smart Tune Equalization  *.equ 
    Advanced Settings  *.ads 
    These settings can be opened and then saved as a *.set file. 
 
Triggers 
  Advanced Trigger File  *.piat 
  Simple Trigger File  *.smp 
  Packet File  *.pkt 
 
Simple Search 
  Packet File  *.pkt 
 
Trace Validation 
  Validation, state machine and diagram files  *.pitv 
 
Stimulus Editor/Builder files 
  Stimulus Editor Files  *.pie 
 
Some file extensions changed with v1.8.0, however legacy file extensions are still supported for backward 
compatibility. 
 

Test Menu 
Test→Run 

Starts the Stim and Trace Validation tests selected and configured in the Configuration windows. 

Test→Stop 

Stops the tests that are currently running. 

Results Menu 
Results→Clear Stimulus Results 

Results→Clear Trace Validation Results 

Results→Clear All Results and Data 

Selecting these menu options will clear the respective Results window or windows of all test results. 

Results→Calculate Options 

This forces a calculation of any uncalculated trace data. Only valid options that have not been calculated 

will be active. 
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Reports Menu 
Reports→Trace Validation Results 
Reports→Stimulus Results 

Summary reports can be created by configuring the TV Results and Stimulus Results windows 

(grouping, summarizing, sorting, filtering and expanding levels) and then printing them from this 

menu. This menu will reproduce exactly what is reflected in the Results window to a PDF file. Reports 

can also be exported to a CSV or XML file. 

Reports→UniPro Packet List 

Reports→UFS Packet List 

A Packet List report can be generated from a Packet List window.  

This menu will reproduce exactly what is reflected in the Packet List window to a PDF file. 

View Menu 
Any windows that have been closed will be opened by selecting these options. Restore Default Layout will 

restore the default window and toolbar layout. 

Analyzer Control Menu 
Analyzer Control→Connect 
Analyzer Control→Start 
Analyzer Control→Stop 

These menu items provide the same functionality as the Analyzer status/control tool bar. Clicking Connect 

will establish a connection between the analyzer application and the instrument hardware if it is available. 

Clicking Start or Stop will begin or end a trace capture. 

Tools Menu 
Tools→ Trigger 

The Trigger dialog is used to create, modify and set triggers. 

Tools→ Filter 

Selecting this menu option will open the Filter window. See FILTER WINDOW for more information. 

Tools→ Eye Monitor 

This will be enabled in a future release of the software. 
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Tools→ Editor 

Editor→ Open Editor 

This launches Protocol Insight’s Visual Studio Editor tool as a separate application for editing existing 

or creating new Advanced Triggers, Trace Validation or Stimulus tests. 

Editor→New Advanced Trigger 

This launches Protocol Insight’s Visual Studio Editor tool as a separate application and opens a new 

Advanced Trigger file. 

Editor→New Trace Validator 

This launches Protocol Insight’s Visual Studio Editor tool as a separate application and opens a new 

Trace Validator project. 

Editor→New UniPro Stimulus 

This launches Protocol Insight’s Visual Studio Editor tool as a separate application and opens a new 

UniPro Stimulus test project. 

Editor→New UFS Stimulus 

This launches Protocol Insight’s Visual Studio Editor tool as a separate application and opens a new 

UFS Stimulus test project. 

Tools→ Streaming Statistics 

The Streaming Statistics dialog displays information on the 

streaming performance (bandwidth and bottlenecks) of the 

Thunderbolt3 connection between the instrument and the 

controller PC. This streaming data is collected continuously any 

time Streaming Capture is used. 

Tools→ Save Debug File 

Settings Menu 
Settings → User Preferences 

See USER PREFERENCES for more information. 

Settings → Instrument Configuration 

See INSTRUMENT CONFIGURATION TAB for more information. 
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Settings → Device Configuration 

See DEVICE CONFIGURATION TAB (G550C ONLY) for more information. This will be greyed out and inactive 

if Analyzer mode is selected. 

Settings → Database Configuration 

See DATABASE CONFIGURATION TAB for more 

information. 

The Microsoft SQL Server and instrument-

specific database settings are configured 

automatically with the initial software 

installation. However, in some instances it may 

be necessary to reset your database settings, 

reconfigure your database or re-install it 

manually from scratch. The Database 

Configuration dialog is used to update and save 

settings to repair the database.  

 

See APPENDIX A: RESETTING YOUR SQL DATABASE thru APPENDIX C: MANUALLY INSTALLING MICROSOFT SQL 

SERVER for more information. 

Settings → Packet Display 

See PACKET DISPLAY TAB for more information. 

Settings → User Toolbar 

See USER TOOLBAR TAB for more information. 

Settings → Smart Tune Equalization 

See SMART TUNETM EQUALIZATION TAB for more information. 

Settings → Advanced Settings 

See ADVANCED SETTINGS TAB for more information.  
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Help Menu 
Help → User Manuals 

User Manuals are provided for the instrument, Advanced Trigger, Trace Validation Editor, and Stimulus 

Editor. 

Help → Compatibility-> Test Case Revisions and Interpretations… 

Selecting Test Case Revisions and Interpretations… will launch a web browser and navigate to a web page 

which provides regularly updated information on test cases that have been revised or required 

interpretation to develop. 

Protocol Insight may revise certain test cases from the strict interpretation of the UniPro or UFS CTS to 

facilitate effective and accurate test execution. Any revisions are described here. 

Interpretation of some test cases may have been required to account for ambiguities in the UFS spec, the 

UniPro spec, and/or the CTS specs. To complete the development of the CTS tests Protocol Insight may 

have made certain interpretations which could alter the results of the test cases; those interpretations 

are described here. 

Help → Compatibility->Known Issues… 

Selecting Known Issues… will launch a web browser and navigate to a web page which provides regularly 

updated information on any known issues with the application software or firmware. 
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Post-Capture Analysis  

Trace Validation 
Trace Validation (TV) is a state machine analysis tool that analyzes captured traces using specific and|or 

logic and states to find problems and events. TV tests can be run against any captured trace as a complete 

post-capture analysis tool for search, pass/fail testing, stress test analysis or for general debug.   

There are generally four types of TV tests that can be run: pre-defined CTS tests, debug tests, SearchTVs 

and custom tests. The application software library includes hundreds of pre-defined CTS, debug and 

search TVs that can be used as-is or modified and saved as their own unique analysis test cases. And the 

user can use Trace Validation Editor to create their own custom TV tests. 

Pre-defined CTS tests are supplied with the application software library for most UniPro and UFS CTS tests 

defined by the respective standards organizations.  

When these CTS tests are executed the Exerciser/Analyzer inserts a specific Protocol Insight marker packet 

into the trace to indicate the beginning of each CTS test in the trace (see TEST EXECUTION AND TRACE 

VALIDATION ANALYSIS FOR FALCON  for more information). If TV does not find the marker packet TV will not 

complete and will instead generate the message “State machine did not run”.  

For this reason, the TV CTS tests supplied with the application software library should only be used to 

analyze traces generated with the exerciser with the matching CTS Stim test case containing a marker 

packet. 

The pre-defined CTS tests are designed to follow the exact packet sequence defined in each CTS. For 

example, in JESD224A, the CTS test 8.1.3 “UFS_ContextManagement_03” requires the following specific 

packet sequence: 

1. Issue Query Request Write Attribute command to set wContextConf for read and write operation 

2. Issue READ (10) command 

3. Issue WRITE (10) command 

4. Issue Query Request Write Attribute command to clear wContextConf (INDEX = N). 

Therefore, the TV test for UFS CTS 8.1.3 specifically requires a Query Request Write Attribute command 

followed by a Read (10) followed by a Write (10) followed by another Query Request Write Attribute 

command. If these packets are not found in this sequence the test will fail.  

Debug tests are designed to analyze any trace, not just ones generated by the exerciser for CTS, to find 

issues that are commonly associated with UniPro or UFS turn-on problems. Examples include Link Startup 

problems and Powermode Change failures. Debug tests are intended to be used with traces captured in 

either exerciser or analyzer mode. If no states in the captured trace match the criteria of the debug TV, 

the message “State machine did not run” will be generated. See APPENDIX E: DEBUG TEST DESCRIPTIONS for 

a list and explanation of these tests. 

SearchTVs are tests created by Protocol Insight to search a trace for specific conditions. The application 

software library includes three search TVs, “Find UniPro Error Packets“, “Find UFS Error Packets” and “Find 

Protocol Insight CTS Markers”. 
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Custom TV tests can be created by the user, either from scratch or from a pre-defined test in the 

application software library. See the separate Trace Validation Editor User Manual for more information. 

Trace Validation Results - Group and Summarize 
Analysis of results in the TV Results window can be done with grouping. To group click on any column 

header and drag into the Test Results field. This will summarize the results with an item count of 

occurrences.  Multiple column headers can be dragged into the Test Results field (1) to create tiered 

groupings for analysis: 

 

Figure 7: Grouping and Summarizing 

The item count represents the number of items in the grouping below, so in this example (2) “Test Name: 

UniPro: Power Mode Change” counted 4 items, representing 4 different test results. This item count 

summing function can be manipulated with a high degree of flexibility by reordering the groupings to 

count different items in addition to tests, such as number of Failures (Status) or Rules. 

Summary Status flag: for any grouping of results the summary status flag represents the worst-case result 

of the grouping (3).  In this example, 4 results were determined for “Test Name: UniPro: Power Mode 

Change”, and the worst result was a Failure so “Test Name: UniPro: Power Mode Change” is marked as 

Failure. 
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Trace Validation Results - Sort and Filter 
In the TV Results window any column header can be clicked to filter out results or to sort results by that 

column: 

 

Figure 8: Sorting and Filtering 

UniPro and UFS Packet List windows 
The Packet List windows display all packets. See UNIPRO AND UFS PACKET LIST WINDOW for more details. 

UniPro and UFS Events windows 
The Events windows display all events in a trace, with separate rows for significant events such as speed 

changes, UniPro packets and UFS READs and WRITEs. Zooming is can be accomplished by dragging a zoom 

box in the Events window, and the controls on the left side of the Events window can undo zoom or 

otherwise control display zooming. See UNIPRO EVENTS WINDOW for more details. 

Packet Decode and Data View windows 
To display the protocol decode of a packet of interest in the Packet Decode window click on the packet in 

the TV Results window or in the appropriate Packet List window. Hovering over a bit in the Packet Decode 

window displays additional decode information Selecting 8, 16, or 32 defines the bit width of the display. 

Full payload is displayed in the Data View window. See PACKET DECODE WINDOW and DATA VIEW WINDOW 

for more details. 

Analysis Reports 
TV Results and Packet List reports can be created by configuring the appropriate window and then printing 

it. See REPORTS MENU for more information.  
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Operational Overview and Theory of Operation 
Trace Validation is the analysis engine for compliance/conformance testing (CTS), corner case, margin and 

automated stress testing, and sniffer-style trace capture, analysis and debug. 

Trace Validation is a complex state machine system that processes analyzer traces algorithmically and 

applies state machine logic to packet sequences to verify conformance or compliance to the specifications. 

 

Figure 9: Example UniPro Power Mode Change Trace Validation State Machine 

Interpreting Trace Validation Results 
The Trace Validation engine performs protocol sequence and packet inspection with five possible status 

results for each rule check displayed in the Trace Validation Results window: 

Failure 

Any protocol sequence or packet that does not meet a rule specified in MIPI UniPro v1.1 CTS, the 

JEDEC JESD224 or JESD224A CTS, or as defined in a custom test case 

Warning 

Any protocol sequence or packet that does not conform to 

a “shall” specified in MIPI UniPro spec, JEDEC JESD220x 

spec, or as defined in a custom test case 

Pass 

Any protocol sequence or packet that conforms to the 

UniPro spec and CTS and JEDEC spec and CTS. 

Info 

Info messages communicate the progress during the test 

or information about the packets, and are typically 

followed by a status result such as Pass or Failure. See 

example to the right, where there are several Info 

messages followed by a Success message and Pass status.  

Debug            (TV mode only) 

Provides information on state machine execution of an inspection rule in Trace Validation if debug 

hooks were placed in the TV test case: 

 Indicates an Action was executed. This could be a Log Message Action, Counter Action, or 
a Set or Modify Variable Action run by either a State or an Event. 

 Indicates that an Event fired and triggered a transition to a new State. Events fire when 
all their Validators are true.  

 Indicates that the Trace Validation engine transitioned into a new State. 

 Indicates that a Validator was tested and the result was true.  
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Indicates that a Validator was tested and the result was false. 
The results can be grouped, summed, sorted and filtered by various test parameters or packet 

characteristics.  See TRACE VALIDATION RESULTS - GROUP AND SUMMARIZE  and TRACE VALIDATION RESULTS - 

SORT AND FILTER for more information. 

Test execution and Trace Validation analysis for Falcon Exerciser/Analyzer 
To execute compliance/conformance testing (CTS), corner case, margin and automated stress testing in 

“CTS and Exerciser + Analyzer” mode the test cases are initiated by the exerciser and the Trace Validation 

engine is used to verify the results. Trace Validation examines the trace to verify that the protocol 

sequences and packets conform to the UniPro or UFS CTS, specifications or custom tests. This flowchart 

shows the operation: 

 

Figure 10: Test executive exerciser operation 

For UniPro CTS testing, to locate the beginning of each test case in the trace a PACP_SET_req marker 

packet is inserted followed by the packet(s) necessary to commence the test. The marker packet contains 

a value that uniquely identifies the test case: 

• The PACP_SET_req MIBattribute value identifies the author of the test case. The predefined 

ranges are listed below. 

• 0xFFFF – Test case authored by Protocol Insight  
• 0xFF00-0xFFFE – This range reserved  
• 0xF000-0xFEFF – Range available range for customer defined test cases. 

 

• The MIBvalue identifies the specific test being executed:  

• Domain (8 bits) – Used to define a category of test case for the given owner. Existing Protocol 
Insight domains are: 
• 01 - CTS specific test cases 
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• 02 - Power mode tests 
• Case ID (24 bits) – Identifies a specific test case within a given domain. Protocol Insight test 

cases follow a major, minor, revision style using 8 bits for each.  

For example, the CTS test case 1.1.4 Invalid Configuration Request written by Protocol Insight 

would have a complete ID of 0x01010104. 

For UFS CTS testing, to locate the beginning of each test case in the trace a NOP OUT packet is inserted 

with the follow reserved bits set:  

• Reserved Bytes 12 & 13 – Place the Protocol Insight Flag - 0xFFFF  

• 0xFFFF – Test case authored by Protocol Insight  
• 0xFF00-0xFFFE – This range reserved  
• 0xF000-0xFEFF – Range available range for customer defined test cases. 

• Reserved Bytes 14 – 17 –The four parts of the test case ID 

• Domain (8 bits) – Used to define a category of test case for the given owner. Existing Protocol 
Insight domains are: 

▪ 01 - CTS specific test cases 
▪ 02 - Power mode tests 

• Case ID (24 bits) – Identifies a specific test case within a given domain. Protocol Insight test 
cases follow a major, minor, revision style using 8 bits for each. 

Test execution and Trace Validation analysis for analyzer 
This flow charts shows the operation of the test executive for “sniffer” style Trace Validation analysis: 

 

Figure 11: Trace Validation operation 
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Warranty 
For Product(s): 

Protocol Insight warrants that this product will be free from defects in materials and workmanship for a 

period of one (1) year from the date of shipment. If any such product proves defective during this warranty 

period, Protocol Insight, at its option, either will repair the defective product without charge for parts and 

labor, or will provide a replacement in exchange for the defective product. Parts, modules and replacement 

products used by Protocol Insight for warranty work may be new or reconditioned to like new performance. 

All replaced parts, modules and products become the property of Protocol Insight. 

In order to obtain service under this warranty, Customer must notify Protocol Insight of the defect before 

the expiration of the warranty period and make suitable arrangements for the performance of service. 

Customer shall be responsible for packaging and shipping the defective product to the location designated 

by Protocol Insight, with shipping charges prepaid. Customer shall be responsible for paying all shipping 

charges, duties, taxes, and any other charges for products returned to any locations. 

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or 

inadequate maintenance and care. THIS WARRANTY SHALL NOT APPLY TO ANY DAMAGE TO 

INSTRUMENT FRONT-PANEL CONNECTORS. Protocol Insight shall not be obligated to furnish 

service under this warranty a) to repair damage resulting from attempts by personnel other than Protocol 

Insight representatives to install, repair or service the product; b) to repair damage resulting from improper 

use or connection to incompatible equipment; c) to repair any damage or malfunction caused by the use of 

non-Protocol Insight supplies; or d) to service a product that has been modified or integrated with other 

products when the effect of such modification or integration increases the time or difficulty of servicing the 

product. 

THIS WARRANTY IS GIVEN BY PROTOCOL INSIGHT WITH RESPECT TO THE PRODUCT IN 

LIEU OF ANY OTHER WARRANTIES, EXPRESS OR IMPLIED. PROTOCOL INSIGHT AND ITS 

VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

A PARTICULAR PURPOSE. PROTOCOL INSIGHT' RESPONSIBILITY TO REPAIR OR REPLACE 

DEFECTIVE PRODUCTS IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE 

CUSTOMER FOR BREACH OF THIS WARRANTY. PROTOCOL INSIGHT AND ITS VENDORS 

WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL 

DAMAGES IRRESPECTIVE OF WHETHER PROTOCOL INSIGHT OR THE VENDOR HAS 

ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES. 

For Software and Documentation: 

Protocol Insight warrants that (a) the physical medium on which this Software or Documentation is 

distributed is free from defects in materials and workmanship under normal use; (b) the Software will 

perform substantially according to the relevant Documentation when used as instructed in the 

Documentation; and (c) Protocol Insight has the right and authority to grant the License and to perform 

its other obligations under this Agreement. This limited warranty shall expire 30 days after delivery of the 

Software to Licensee. To the fullest extent permitted by law, THE ABOVE-STATED LIMITED WARRANTY IS 

THE ONLY WARRANTY MADE BY PROTOCOL INSIGHT OR ITS LICENSORS AND REPLACES ALL OTHER 

WARRANTIES, EXPRESS OR IMPLIED, AND PROTOCOL INSIGHT DISCLAIMS AND LICENSEE WAIVES ALL 

OTHER REPRESENTATIONS, WARRANTIES, OR CONDITIONS, INCLUDING WITHOUT LIMITATION, THE 
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IMPLIED WARRANTIES OF TITLE, MERCHANTABILITY, NONINFRINGEMENT, AND OF FITNESS FOR A 

PARTICULAR PURPOSE.  

Notwithstanding the foregoing, PROTOCOL INSIGHT AND ITS PROTOCOL INSIGHTS ARE NOT LIABLE TO 

LICENSEE FOR ANY DAMAGES, INCLUDING, WITHOUT LIMITATION, DIRECT, COMPENSATORY, SPECIAL, 

INCIDENTAL, EXEMPLARY, PUNITIVE, OR CONSEQUENTIAL DAMAGES, CONNECTED WITH OR RESULTING 

FROM THIS AGREEMENT OR LICENSEE'S USE OF THE LICENSED PRODUCTS, REGARDLESS OF ANY 

KNOWLEDGE OF OR NOTIFICATION TO PROTOCOL INSIGHT OF THE LIKELIHOOD OF SUCH DAMAGES 

OCCURRING. In any event, Protocol Insight’s total aggregate liability for all damages, losses, claims, 

liabilities, expenses and costs arising from or related to the products under any and all theories of liability 

shall be the amount paid by Licensee to Protocol Insight for the product in question. 
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Appendix A: Resetting Your SQL Database  
Follow these steps to reset your SQL database: 

1. Launch Protocol Insight application software. 

2. Select Settings → Database Settings. 

3. Enter the following: 

a. Server Name: "localhost\ProtocolInsight". 

b. Database Name: "ProtocolInsight". 

c. Authentication Type: "Windows Authentication". 

4. Click Repair Database. 

 

5. Click Yes on the warning message box. 

6. You should get a dialog box saying: "Database was restored successfully". 

7. You can now use the software normally. 
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Appendix B: Reconfiguring your SQL Database  
Follow these steps to reconfigure your SQL database: 

1. Launch Protocol Insight application software  

2. Select Settings → Database Settings 

3. Enter the following 

Server name: Enter the SQL Server instance to connect to. By 

default this should be localhost\Protocolinsight.  

Database Name: The name of the database on the server. By 

default this is Protocolinsight.  

Authentication Type: Two authentication modes are available when connecting to an instance of 

the Database Engine: 

Windows Authentication - Microsoft Windows Authentication mode allows a user to connect 

through a Windows user account. 

SQL Server Authentication - When a user connects with a specified login name and password 

from a non-trusted connection, SQL Server performs the authentication itself by checking to 

see if a SQL Server login account has been set up and if the specified password matches the 

one previously recorded. If the Authentication Type selected is SQL Server Authentication: 

User Name: The SQL Server login id to connect to SQL Server should be “sa” if you are 

using the Default Password (see below). 

Password: The Password to connect to SQL Server with.  

Use Default Password: This will override the password with the default password for the 

sa account. User Name must be “sa” and the SQL Server install must be the default from 

installing the software.  

When you have entered all the data, click Test Connection to make sure the server, database, and 

security are valid.  
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Appendix C: Manually Installing Microsoft SQL Server  
Follow these steps to manually install and configure your SQL database: 

NOTE: If you are manually installing during setup, start with Step 3. 

1. Obtain the SQL Server 2017 Express edition installation media from Microsoft 

a. https://www.microsoft.com/en-us/download/details.aspx?id=55994 

b. Click Download 

2. Run SQLServer2017-SSEI-Expr.exe from your download location. 

3. On the "Select an installation type" screen, choose Custom 

 
4. Select a download media location and Click Install 

At this point the installation files will be downloaded from Microsoft. Once complete, the 

installation should start. 

5. SQL Server Installation Center - Click Installation on the list of options in the left pane 

  

https://www.microsoft.com/en-us/download/details.aspx?id=55994
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6. Click " New SQL Server stand-alone installation or add features to an existing installation" 

 
7. Install Rules – Verify that you don't have any required updates and click Next  

8. Installation Type – Choose Perform a new installation of SQL Server 2017 and click Next 

9. License Terms – Check I accept the license terms  and click Next 

10. Features Selection – Click the Unselect All button and then choose only the "Database Engine 

Services" feature. Click Next (You can optionally change the installation drive if you need to 

install to a drive other than C:\) 
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11. Instance Configuration – Choose Named Instance and Enter "ProtocolInsight" as the instance 

name. The Instance ID should automatically update to "PROTOCOLINSIGHT". Click Next. 

 

12. Server Configuration – Leave the default options, click Next. 

13. Database Engine Configuration – Click the Add Current User button if the current windows user 

is not listed in the Specify SQL Server Administrators box. Click Next. 

14. Wait for the installation to complete and click Finish. 
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Appendix D: Blank 
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Appendix E: Debug Test Descriptions  

UFS Debug Tests 

UFS Stimulus 
The following stimulus tests perform as the test name implies. For example, the “Read BusyRTC Flag” 

reads the BusyRTC flag. 

Read BackgroundOpsEn Flag Read bBackgroundOpStatus Attribute 

Read BusyRTC Flag Read bBootLunEn Attribute 

Read Configuration Descriptor Read bConfigDescrLock Attribute 

Read Device Descriptor Read bCurrentPowerMode Attribute 

Read Device Health Descriptor Read bDeviceCaseRoughTemperature Attribute 

Read Device Init Flag Read bDeviceFFUStatus Attribute 

Read DeviceLifeSpanModeEn Flag Read bDeviceTooHighTempBoundary Attribute 

Read Geometry Descriptor Read bDeviceTooLowTempBoundary Attribute 

Read Interconnect Descriptor Read bMaxDataInSize Attribute 

Read Manufacturer Name String Descriptor Read bMaxDataOutSize Attribute 

Read OEM ID String Descriptor Read bOutOfOrderDataEn Attribute 

Read PermanentWPEn Flag Read bPSAState Attribute 

Read PermanentlyDisableFwUpdate Flag Read bPurgeStatus Attribute 

Read PhyResourceRemoval Flag Read bRefClkFreq Attribute 

Read Power Parameters Descriptor Read bRefClkGatingWaitTime Attribute 

Read PowerOnWPEn Flag Read bRefreshFreq Attribute 

Read Product Name String Descriptor Read bRefreshMethod Attribute 

Read Product Rev Level String Descriptor Read bRefreshUnit Attribute 

Read PurgeEnable Flag Read dDynCapNeeded Attribute 

Read RPMB Unit Descriptor Read dPSADataSize Attribute 

Read RefreshEnable Flag Read dSecondsPassed Attribute 

Read Serial Number String Descriptor Read wContextConf Attribute 

Read Unit Descriptor Read wExceptionEventControl Attribute 

Read bActiveICCLevel Attribute Read wExceptionEventStatus Attribute 

 

UFS Trace Validation 

Command Response 

This test checks that every Command sent by the tester receives a Response from the DUT. 
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Latency 

This Trace Validation test is a generic framework which can be customized to measure latency response 

between packets. It will measure and compute the min, max, and average latency between packets of 

interest. In addition, it has a threshold value, vLatencyThreshold, defined in the Idle state that can be used 

to set a Pass/Fail criteria on the measured latency. It looks for packets in either direction but can be 

modified to look only in one direction by using Metadata Validators. This framework was used to create 

the Command Response and DataIn Packet latency tests. 

Latency Command Response 

This test measures the latency between a Command transaction code and a Response transaction code. 

It looks for packets in both directions. The vLatencyThreshold variable in the Idle state can be modified to 

set a Pass/Fail criteria. The resulting measurement value is in pSec. 

Latency DataIn Packet 

This test measures the latency between a Read Command and the DATAIN response. It looks for packets 

in both directions. The vLatencyThreshold variable in the Idle state can be modified to set a Pass / Fail 

criteria. The resulting measurement value is in pSec. 

READ(10) 

This test will check for the correct response to READ(10) / WRITE(10) commands from the tester to the 

DUT. It looks for errors and verifies the correct number of DATA IN / DATA OUT packets. 

Transaction Response 

This test verifies all UFS commands sent by the tester have an appropriate response. It returns the number 

of commands it finds. 

WRITE(10) 

This test will check for the correct response to READ(10) / WRITE(10) commands from the tester to the 

DUT. It looks for errors and verifies the correct number of DATA IN / DATA OUT packets. 

UniPro Debug Tests 

UniPro Stimulus 

FrameSeqNumNAC 

This stimulus test generates data frames with an invalid Frame Sequence Number. It tests the DUTs ability 

to respond correctly to invalid Frame Sequence Numbers. 

Generate Eye Monitor Traffic 

This stimulus test can be used to generate suitable traffic for building eye patterns using the Eye Monitor 

under Tools → Eye Monitor. This will be enabled in a future release of the software. 

HS-Gx-RateX_Terminated (multiple tests) 

HS-Gx-RateX_Unterminated (multiple tests) 

PWM-Gx (multiple tests) 

The above three stimulus test groups test the ability to send and receive one data packet at the specified 

settings. 
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TTCErr 

Type4Err 

Type7Err 

TypeAFCErr 

TypeEOFEvenErr 

TypeEOFOddErr 

TypeNACErr 

The above seven Err stimulus tests generate the type of error implied in their name. They are useful for 

verifying the DUT response to error conditions. 

UniPro Trace Validation 

AFC Sequence Number Order 

This test case verifies that AFC sequence numbers are in order. It accounts for Hibernate and AFC frames 

with errors. 

AFC with CReq Set 

This test verifies that an AFC with CReq set to 0 is sent in response to an AFC with the CReq bit set. 

Check for Packet Errors 

Checks entire trace for any UniPro packet errors. 

CheckCredits 

This test tracks the number of credits sent between the tester and DUT and reports errors if there are too 

many credits available or too many bad data frames 

CountMessages 

This trace validation counts the number of data frames seen both up and down and reports that number. 

Data Frame TC0 Sequence Numbers 

This test tracks the sequence numbers of the data frames and checks for proper replay of NAC’d data 

frames. 

IO Throughput 

This trace validation calculates the instantaneous and average Data Frame throughput from and to the 

DUT. Clicking on an IO Throughput message (Rule) in the TV Results window will move the cursor to the 

Data Frame packet that is the subject of that throughput measurement. 

Link Startup Sequence 

This test verifies proper progression through the seven phases of link startup, in both directions. 

NAC Transmission Disabled 

This test verifies that NAC transmission is disabled until the DL Layer receives one Data or Control frame 

without any error. 

PACP_GET_req 

This test verifies that all get requests are acknowledged with a PACP_GET_cnf. 
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PACP_SET_req 

This test verifies that all set requests with the cnf bit set are acknowledged with a PACP_SET_cnf. 

PowerModeChange 

This test verifies that a PACP_PWR_req power mode change request is properly handled. 

Verify Control Frames 

This test verifies all of the fields in a control frame and checks for any error. 

Verify Data Frames 

This test verifies all of the fields in a data frame and checks for any error. 

Verify NAC Transmission 

This test looks for bad packets and checks for a corresponding NAC. It also looks for unexpected NACs. 

Verify Outstanding Frames 

This test verifies that there is no more than 16 outstanding data frames that are unacknowledged. 
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Appendix F: Steaming Capture  
If Streaming is selected as the Capture Type in Capture Options, the instrument will write the captured 

trace to the controller PC’s SSD drive. Capture Type selected under Settings, Instrument Configuration, 

Capture Options. 

Streaming performance is dependent on a verity of factors including M-PHY gear, PC load, SSD speed, link 

bandwidth utilization and hardware filtered packets. To increase streaming efficiency the pre-capture 

hardware filter should be used to remove as many unnecessary packets as possible before transmission 

over the Thunderbolt 3 interface. 

How Streaming Capture Functions 
As a trace is captured it is buffered through the instrument memory (8GB) to the controller PC’s system 

RAM (configurable, with default value of 4x1GB=4GB) and then saved to the SSD disk. The application 

software will DMA data from the instrument memory to System RAM over the thunderbolt cable; with a 

x4 Thunderbolt connection and compliant cable the transfer speeds should be ~2.4GB/s. In parallel the 

application moves data from the System RAM to disk. The transfer rate from System Ram to disk is 

dependent on system and the disk performance; with the best NVMe disks speeds of > 5.0GB/s are typical. 

Streaming Buffer Usage in the INSTRUMENT STATUS WINDOW displays a graphical representation of the 

amount of the instrument’s embedded memory and the controller PC’s system RAM that is being used as 

a buffer as the trace is being written to the Streaming File on disk. On a controller PC with a slower SSD 

write speed, the system RAM will fill up first, then the instrument's buffer. Once the analyzer capture has 

stopped the Streaming Buffer Usage will gradually decrease down to zero as all data is written from the 

buffers to the disk, and Streaming File Usage will stop incrementing and show the final trace size. 

Testing Streaming Performance 
Under Settings, Instrument Configuration, Streaming Performance Test can be used to characterize the 

system streaming performance. This reports the achievable DMA bandwidth: 

- Instrument to System RAM 

- System RAM to disk.   

If the system does not meet the needed performance the System RAM buffer can be increased in 

Streaming Settings in the Settings, Advanced Settings tab, STREAMING CONFIGURATION RECOMMENDATIONS. 

If you run the Streaming Performance Test and you get bad results, Disk Bandwidth speeds less than 

2100 MB/s for example, you can still use streaming capture. However, the trace capture will stop 

when either the instrument memory, memory buffer or disk overflow for any reason.  
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Streaming Configuration Recommendations 
 

Make sure your system meets the HOST PC 

REQUIREMENTS recommendations. In Settings, 

Advanced Settings you can set the system 

DRAM buffer size that will be used for 

streaming. We recommend you have at least 

4 buffers, each configured for 256MB. Leave 

at least 16GB of RAM free for the instrument 

application software. Example: If you have  

64GB of system RAM, do not exceed 32GB in 

Total Buffer SIze.  

 

Once you change the settings a User Account Control pop-up will implement the buffer space in the 

Windows system. Close the application and restart. Occasionally, settings you make here may require a 

system reboot.  

In Settings, Instrument Configuration make sure you set the Disk Buffer size to an appropriate 

value, depending on the length of time you want to capture and available disk space. In the example 

below we have set the storage size to 100 GB.  
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Appendix 1: Hardware Specifications 
Product specifications are subject to change without notice. 

Instrument 

Analyzer / Exerciser 

• M-PHY Type-I 

• Speeds: 
o High-Speed (HS) Gear1, Gear2, Gear3, Gear4, and Gear5 modes 
o Low-speed Pulse-width Modulation (PWM) Gear1 in Type-I LS implementation 

• Link Width: x1 and x2 

• The Falcon G500C / G550C has a configurable trace capture depth. 

Configuration Order Code Trace Capture Depth 

Base Configuration 8GB 

FG5XXC8GB 15 GB3  

FG5XXC16GB 23 GB1 

FG5XXC24GB 30 GB4 

         

• Probing 
o Analyzer – HS-G5 Solder-down probe, P/N FG5PSD2 
o Exerciser – SMP connections must be used for exerciser functions 

Advanced Trigger 
States: 4 N way branching, Trigger In, Trigger Out, Go To State 
Packet Matchers: 5 per direction (8 Symbol Matchers each).  
Additional State/FLR/SKP matcher: 2 per direction 
Counters: 2 
Compare Actions:  <   (Less Than), ==  (Equal), >   (Greater Than), >=  (Greater Than OR Equal) 
Modify Actions:   Hold      (No Change), Count + 1 (Increment), Count - 1 (Decrement) 
 
Only one Compare Action per Counter can be defined in a trigger.  That one Compare Action is 
available in all states.  You can't program "Counter1 < 5" in one state and then "Counter1 > 5" in 
another state.  If you program "Counter1 < 5" in one state then that is the only Compare Action 
available for Counter1 in any state of the trigger. Either or both counters can be incremented or 
decremented in each state. 

  

 
3 Memory buffer is 16 or 24 GB; 1 GB is used for system functions and unavailable for capture 
4 Memory buffer is 32 GB; 2 GB is used for system functions and unavailable for capture 
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DUT Requirements to Sync Analyzer to a UniPro link 
 

        Attribute    Protocol Analyzer PHY Spec 
TxHsG1SyncLength (0x1552) 256 Symbols, 0x48 Capability value 
TxHsG2SyncLength (0x1555) 256 Symbols, 0x48 Capability value 
TxHsG3SyncLength (0x1556) 256 Symbols, 0x48 Capability value 
TxHsG4SyncLength (0x15D0) 256 Symbols, 0x48 Capability value 
TxHsG5SyncLength (0x15D6) 256 Symbols, 0x48 Capability value 
TxHsG1PrepareLength(0x1553) 0xA Capability value 
TxHsG2PrepareLength(0x1554) 0xA Capability value 
TxHsG3PrepareLength(0x1557) 0xA Capability value 
TxHsG4PrepareLength(0x15D1) 0xA Capability value 
TxHsG5PrepareLength(0x15D7) 
PeerRxHsG4AdaptRefresh (0x15D2) 
PeerRxHsG4AdaptInitial (0x15D3) 
PeerRxHsG5AdaptRefresh (0x15D8) 
PeerRxHsG5AdaptInitial (0x15D9) 

0xA Capability value 
0x91 Capability value 
0x91 Capability value 
0x91 Capability value 
0x91 Capability value 

RxLsPrepareLength 0xA Capability value 
RxPwmBurstClosureLength 0x1F Capability value 
To sync to existing link one Start of Burst 

DUT Requirements to establish a UniPro link with the Falcon exerciser 
The device must execute a UniPro 2.0 or 1.8 compliant Link Startup Sequence. 

Falcon 500C / 550C - I/O Signals and Voltage Outputs 
UFS reference clock output: 19.2, 26, 38.4 and 52 MHz at 1.2V 
UFS_Reset_N or RST: 1.2V output ± 0.3V 

JESD220x requires CLK and RST voltage of 0.65*VCCQ - VCCQ+1.3. This is 0.715-1.6V min 
and max VCCQ and 0.78-1.5V typical VCCQ. The output voltage changes depending on the 
load impedance of the DUT; open circuit voltage is 1.3V and at 50Ω a voltage of 0.90V is 
supported. 

TRIG IN or TRIG OUT: Trigger in to / out from the analyzer: max 1.8V ±0.3V. 
Front panel probe power ±4V 

Falcon G500C / G550C Physical Characteristics  
Dimensions   12.7” x 2.7” x 9.9”, 32.4cm x 6.9cm x 25.0cm 
Weight   [4.6 lbs, 2.1kg] 
Package Dimensions  18" x 18" x 11", 45.72cm x 45.72cm x 27.94 cm 
Package Weight  9.0lbs, 4.08kg 

Operating Conditions 
Falcon series instruments are suitable for use in dry indoor lab locations, they are not intended for use in 
hazardous locations. They should be installed in accordance with local and national code requirements. 
 

Operating Ambient Temperature: 0 to 35 C 

Non-operating Temperature: -20 to 45 C 
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Safety, Compliance and Environmental Information 
Falcon C Series 
Conforms to UL STD 62368-1 
Certified to CSA STD C22.2 No. 62368-1 

ETL Control Number: 5009155 

Complies with IEC 60950-1:2005 (Second Edition) + Am 1:2009 + Am 2:2013 
Manufacturer’s Declaration of Conformity to European Directive 2014/35/EU (Low 
Voltage Directive) 

 
Compliant with the European Union directive 2002/95/EC and 2011/65/EU on the 
Restriction of the use of certain hazardous substances in electrical and electronic 
equipment and components (RoHS). 

 

Compliant with 

CISPR 16-2-3:2016 – radio disturbance and immunity measuring apparatus and methods  

CISPR 16-2-1: 2014/AMD 1:2017 – specifies the methods of measurement of disturbance 

phenomena in general in the frequency range 9 kHz to 18 GHz 

FCC 47CFR 15: 2012 – radio frequency devices 

EN 55032:2015, A11:2020 - Electromagnetic compatibility of multimedia equipment 

EN 55035:2017, A11:2020 

IEC 61000-3-2:2020 – limits For Harmonic Current Emissions 

IEC 61000-3 Ed: 5.1, 2020-07-14 

IEC 61000-3-3:2021 

IEC 61000-3 Ed. 3.2, 2021-03-25 

ICES-003: 2020 - Information Technology Equipment - Limits and Methods of 

Measurement 

ANSI C63.4:2014 – American National Standard for Methods of Measurement of Radio-

Noise Emissions from Low-Voltage Electrical and Electronic Equipment 

IEC 61000-4-2:2008 – (EMC) discharge immunity  

IEC 61000-4-3:2006 – (EMC) Radiated, radio-frequency, electromagnetic field immunity  

IEC 61000-4-5:2 – (EMC) surge immunity test 

IEC 61000-4-6:2008 – (EMC) immunity to conducted distubances 

EN 62368-1:2020+A11:2020 – Audio/video, information and communication technology 

equipment 
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Patents 
This product is protected under US Patent No. 10,613,963 
 

Export Control Classification Number (ECCN) and Schedule-B Harmonization Code 
No. 3B992 b.4.b.1, No License Required 

US Export Schedule-B harmonization code: 9030.89.0100 

Country of Manufacture: USA  
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Appendix 2: System Requirements  

Power Requirements – External Power Supply 
The Falcon B and C series use an external power brick to provide power to the device. The polarity is 

shown in Figure 12 and the plug dimensions are shown in Figure 13.  

  

Figure 12: Back Panel Plug Polarity 

 

Figure 13: Male Power Plug Specifications 

Falcon B Series Power Supply  
• EDAC Power Electronics Co., Ltd model EA1068 

• Universal AC input 100 to 240V AC 

• Output: DC +12V/6A 

• Frequency: 50 to 60Hz 

• Safety: UL/CUL, TUV, CB, FCC, CCC, CE, PSE 

• Meets RoHS and WEEE 

 

 

 

 

 

 

  
Figure 14: EDAC Power Supply 
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Falcon C Series Power Supply – USA, Europe, and China 
• Cincon TRH100A120-12E12 

o ECCN EAR99, 8504.40.9520 

• Universal AC input 100 to 240V AC 

• Output: DC +12V/8.34A (100W) 

• Frequency: 47 to 63Hz 

• Safety: UL/CUL, TUV, FCC, CCC, CE, PSE 

• Meets RoHS and WEEE 

 

 

 

 

 

 

 

 

  
Figure 15: Cincon Power Supply 
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Falcon C Series Power Supply – Japan, Korea, China, Taiwan 
• GlobTek GTM961200P10812-T3 (P/N TR9CE9000YL4CIMR6B) 

o ECCN EAR99, HTSUS 8504.40.9520 

• Universal AC input 100 to 240V AC 

• Output DV + 12V/9A (108W) 

• Frequency: 50 to 60 Hz 

• Safety: UL, CE, Taiwan BSMI, China CCC, Korea KC Mark, Japan PSE 

• Meets RoHS and WEEE 

 

Figure 16: GlobTek Power Supply 

• Ships with Mean Well DC PLUG-R7BF-P1M (DC 4-pin to 2.5 mm barrel adapter) 

o ECCN EAR99, HTSUS 8536.69.8000 

 

  Figure 17: Mean Well Adapter 

https://en.globtek.com/model/ict-ite-medical-power-supply/desktop-external/gtm961200p120vv-v-t3/w71078
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Host PC Requirements 
Basic configuration: 

• Intel® Core™ i7 or i9 processor or equivalent. 

• 64 GB RAM recommended, 32 GB minimum. 

• NVMe solid state drive with 1TB free space recommended, 256GB minimum free space. 

• Thunderbolt 3 (preferred) enabled type-c connector required, Thunderbolt 4 can also be used 

To take full advantage of streaming capture with v2.0.0 and later FW/SW we recommend: 

• The fastest processor available, e.g. Intel i9-12900HK Processor (5.0GHz turbo) 

• 64GB of RAM recommended, 32GB minimum 

• 1TB NMVe SSD with Sustained Write Bandwidth of 5.0GB/s recommended, 2.5GB/s minimum 

Software Requirements 
• Windows 10 64-bit operating system (preferred), Windows 11 can be used 

• Microsoft SQL Server 2017 or later 

• Microsoft Visual Studio 2015 Community or Professional Edition 

or 

Microsoft Visual Studio 2015 Isolated Shell 

• Falcon G500C / G550C - Protocol Insight application software and firmware version 2.7.7 or later 

is required. The Falcon G500C / G550C will not work with the version 2.6.x series of software. 

• Falcon G400C / G450C - Protocol Insight application software and firmware version 2.6.x series 

is required. Version 2.7.x and later will not work correctly with the Falcon G400C / G450C 

instrument.  



 

Product specifications and descriptions in this document are subject to change without notice. 

© Protocol Insight, LLC 2014 – 2023, Revision 3.3.5, September 2023 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  


